
 

To our customers, 
 

Old Company Name in Catalogs and Other Documents 

 
On April 1st, 2010, NEC Electronics Corporation merged with Renesas Technology 

Corporation, and Renesas Electronics Corporation took over all the business of both 
companies. Therefore, although the old company name remains in this document, it is a valid 
Renesas Electronics document. We appreciate your understanding. 
 

Renesas Electronics website: http://www.renesas.com 
 
 
 
 

April 1st, 2010 
Renesas Electronics Corporation 

 
 
 
 
 
Issued by: Renesas Electronics Corporation (http://www.renesas.com) 

Send any inquiries to http://www.renesas.com/inquiry. 

 



Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
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“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 
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systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 
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the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
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PrefacePrefacePrefacePreface    
The PD72 is the emulator debugger to control the PC4400 Emulator for the 720 series 
of 4-bit microcomputers. This user’s manual describes the features of the PD72 and 
how to set up and use the PD72. 
 
Rights to the ProgramRights to the ProgramRights to the ProgramRights to the Program    
The rights to use the programs included in this product package conform to provisions 
set forth in the Software License Agreement.The PD72 program can only be used for 
the purposes of product development by the user, and cannot be used for any other 
purposes. 

Note also that the information in this manual does not convey any guarantee or license 
for the use of software.  
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1. PDPDPDPD72727272 Introduction 

The PD72 is the emulator debugger software (Windows version) to control the PC4400PC4400PC4400PC4400 
Emulator for the 720 series of 4-bit microcomputers. 
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2. PDPDPDPD72727272 Features 

2.12.12.12.1    MultiMultiMultiMulti----Windowing FunctionWindowing FunctionWindowing FunctionWindowing Function    
PD72 supports multiple overlapping windows, enabling you to simultaneously view a wide 
range of data. Each window contains menus and buttons, allowing commands to be 
executed by clicking with the mouse. 
 

2.22.22.22.2    Break FunctionsBreak FunctionsBreak FunctionsBreak Functions    
PD72 has the following two break functions: 
 

2.2.12.2.12.2.12.2.1    Software BreakSoftware BreakSoftware BreakSoftware Break    
Software breaks allow program execution to be stopped after the command at the specified 
address. The point at which this break occurs is called the software breakpoint. You can 
set software breakpoints from the S/W Break Point Setting dialog box. You can also easily 
set them from the Program Window and Source Window. PD72 supports up to 2 software 
breakpoints. You can set and read in the software breakpoint file via the S/W Break Point 
Setting dialog box. 
 

2.2.22.2.22.2.22.2.2    Hardware BreakHardware BreakHardware BreakHardware Break    
Hardware break causes the target program to break when an event occurs in the target 
MCU.  The target program can be made to break when execution of a specified address 
(Fetch) is detected or the rising or falling edge of a signal input from an external trace 
cable is detected.  The former is called an address break and the latter is called a trigger 
break.  PDPDPDPD72727272 allows you to set two address breakpoints and one trigger breakpoint.  A 
combinatorial condition of these three breakpoints can also be set.  Use the H/W 
Breakpoint Setup dialog box to set these break conditions. 
 

2.32.32.32.3    RealRealRealReal----Time Trace Function Time Trace Function Time Trace Function Time Trace Function     
PD72 supports a real-time trace function that records the execution history of the target 
program for 4K cycles. The trace point can be set using the Trace Point Setting dialog box. 
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2.42.42.42.4    CovCovCovCoverage Measurement Functionerage Measurement Functionerage Measurement Functionerage Measurement Function    
A coverage measurement function refers to recording the addresses executed (accessed) by 
the target program (C0 coverage). It allows you to check unexecuted addresses after 
program execution has stopped. Using this coverage measurement function in a test 
process, it is possible to check the test items that have been omitted. 

2.52.52.52.5    Time Measurement FunctionTime Measurement FunctionTime Measurement FunctionTime Measurement Function    
A time measurement function refers to measuring the execution time of the target 
program. It allows you to measure the execution time of a given processing routine. 
 

2.62.62.62.6    Source Level Debugging FunctionSource Level Debugging FunctionSource Level Debugging FunctionSource Level Debugging Function    
You can display source files and perform source level debugging such as setting break 
points in the source lines and performing step execution. PD72 allows debugging at the 
assembly language level. 
z You can use the Program Window and Source Window to view source files. 
z You can use the ASM Watch Window to view ZXY symbols and bit symbols in 

assembler source files. 
z You can use labels and symbols to specify the addresses of breakpoints. 
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3. PDPDPDPD72727272 Input and Output Files 

3.13.13.13.1    Input FilesInput FilesInput FilesInput Files    
PDPDPDPD72727272 processes the following input files. 

3.1.13.1.13.1.13.1.1    Intel HEXIntel HEXIntel HEXIntel HEX----format Filesformat Filesformat Filesformat Files    
The Intel HEX format files contain machine language information. The file attribute is 
“.hex.” The Intel HEX format files consisting of only the low-order data with the file 
attribute “.hel” and the Intel HEX format files consisting of only the high-order data with 
the file attribute “.heu” can be handled as the input files for the PD72. These files are 
generated by the Absolute Assembler ASM72. 
 

3.1.23.1.23.1.23.1.2    Symbol FilesSymbol FilesSymbol FilesSymbol Files    
This file contains debug information such as symbol information and line number 
information. A SYM file can be generated by specifying the “-S” option when executing 
ASM72(The “-C” option outputs the source line information). The file attribute is “.SYM”. 
Although a SYM file is not necessarily required for PDPDPDPD72727272 to operate, most of its functions 
are unavailable to use without a SYM file read in. Therefore, always be sure to read in a 
SYM file along with a HEX file. 
 

3.1.33.1.33.1.33.1.3    Data FilesData FilesData FilesData Files    
A data file contains the information inherent in the target MCU. This data file is included 
with the product package.  The file name is "M34xxxxx.DAT" (M34xxxxx denotes an 
MCU name). 
The data file is an information file necessary to accommodate differences in MCU 
specifications when MCU types are changed. 
 

3.1.43.1.43.1.43.1.4    Script FileScript FileScript FileScript File    
The script file is for automatic execution of script commands. This file, which is read from 
the Script Window, takes the attribute ".scr". 
 

3.1.53.1.53.1.53.1.5     Help File Help File Help File Help File    
The help file contains help messages for PDPDPDPD72727272. This file, which is supplied with PDPDPDPD72727272, 
takes the attribute ".chm". 
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3.1.63.1.63.1.63.1.6    Environmental Setup FilEnvironmental Setup FilEnvironmental Setup FilEnvironmental Setup Fileeee    
The environmental setup file, which is automatically generated by PDPDPDPD72727272 and cannot be 
directly created or edited by the user, stores information about the environmental setup of 
PDPDPDPD72727272. The filename is PD72.ini. The environmental setup file is saved to the Windows 
directory (the directory in which you have installed Windows). 
 

3.2 Output FilesOutput FilesOutput FilesOutput Files 
PDPDPDPD72727272 outputs the following files. 

3.2.13.2.13.2.13.2.1     Intel HEX Intel HEX Intel HEX Intel HEX----format Filesformat Filesformat Filesformat Files    
The Intel HEX-format files store machine language data. These files, which are saved 
using PDPDPDPD72727272's upload function, take the attribute ".hex". Files saved in the Intel HEX 
format can be downloaded by PDPDPDPD72727272. 
 

3.2.23.2.23.2.23.2.2     Disassemble Files Disassemble Files Disassemble Files Disassemble Files    
Disassemble files store the results of disassembling program memory. These files, which 
are reference text files, take the attribute ".txt". Disassemble files cannot be reassembled 
or downloaded. 
 

3.2.33.2.33.2.33.2.3     Log File Log File Log File Log File    
The log file is a text file containing the results of executing the script commands. This file, 
which takes the attribute ".log", contains the results from the logon point to the logoff 
point. 
 

3.2.43.2.43.2.43.2.4     View File View File View File View File    
The view file is a text file that contains the contents of the script window. In PDPDPDPD72727272, the 
last 1000 lines of the results of executing the script commands are stored in the view 
buffer. The view file, which takes the attribute ".viw", contains the contents of the view 
buffer. 
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1.1.1.1.    SetupSetupSetupSetup    

1.11.11.11.1    InstallationInstallationInstallationInstallation    
See the Release Notes provided with the product for how to install PDPDPDPD72727272. 

1.21.21.21.2    Starting Starting Starting Starting PD72    
Follow the instructions below to start PDPDPDPD72727272: 

 
Click the start button, then select  
program (P)->[RENESAS-TOOLS]->[PDPDPDPD72727272 V.x.xx Release x] 

 
This operation starts PDPDPDPD72727272 (the emulator debugger). 
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1.31.31.31.3    PD72 Setup Setup Setup Setup    
When you start PDPDPDPD72727272, the Init dialog box is displayed, allowing you to set up the operating 
environment. 
 

1.3.11.3.11.3.11.3.1    Init Dialog Box Screen ConfigurationInit Dialog Box Screen ConfigurationInit Dialog Box Screen ConfigurationInit Dialog Box Screen Configuration    
 

 

Switches Resume ON/OFF 

Switches Auto Downloading ON/OFF when restarting 

Area for specifying script file to be run at start up 

Area for setting default tab values 

Area for setting size of default font 

Switches Init dialog box ON/OFF when restarting 

Area for setting the communication interface 

 

1.3.21.3.21.3.21.3.2    Environment SetupEnvironment SetupEnvironment SetupEnvironment Setup    
1. Specifying the script file to be executed at startup 

Specify a script file if you want to execute script commands at startup. These commands 
must have been saved as a script file. Click the "Refer" button to open the file selection 
dialog box, then use the mouse to select the script file to be executed at startup. The 
selected script file is displayed after InitFile: in the Init dialog box. 

 
2. Setting the communication interface 

Set the communication port in the Serial Port area of the dialog box. 
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3. Setting of default TAB values 
Specify the default tab values for the Program Window, Source Window. You can specify 
TAB values between 1 and 32. 

 
Note: 

You can set the tabs independently in each window. With the target window active, 
select [Option] -> [TAB] from the menu in the PDPDPDPD72727272 Window to open the TAB Setting 
dialog box. You can now set the tabs for the active window. 

 
4. Setting of default font size 

Specify the default font for the characters displayed by PDPDPDPD72727272. Click the "Font" button to 
open the Font dialog box, then specify the font and the font size. 
 

Note: 
You can set the font size independently in each window. With the target window 
active, select [Option] -> [Font] from the menu in the PDPDPDPD72727272 Window to open the Font 
Setting dialog box. You can now set the font size for the active window. 

 
5. Switches of Init dialog box ON/OFF of restarting 

Specify whether the Init dialog box should be opened when restarting PDPDPDPD72727272. Check 
"Next Hide" to stop the Init dialog box being opened when you next start PDPDPDPD72727272. If you 
want to display the Init dialog box when you next start PDPDPDPD72727272, select [Init] -> [Environ] 
from the PDPDPDPD72727272 Window menu, then uncheck "Next Hide" in the Init dialog box. You can 
also force the Init dialog box to be displayed when you start up by pressing and holding 
the Ctrl key when starting PDPDPDPD72727272. 

 
6. Switches of Resume ON/OFF 

You can specify whether, when you restart PDPDPDPD72727272, the windows are restored to their 
status when you last quit the program. Check the Resume box to do so. 

 
7. Selection of Auto downloading at startup 

You can specify whether, when you restart PDPDPDPD72727272, the program automatically fetches the 
last-read target program. Check the Auto Download box to do so. 
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1. Window function of Window function of Window function of Window function of PD72 

1.11.11.11.1    The The The The PD72 Window Window Window Window    
The PD72 Window is the main window for PD72. This window displays the main 
commands on a toolbar. You can click on the buttons on this toolbar to run the target 
program in normal or one-step mode. The main display area accommodates windows such 
as the Target Program Window. 

1.1.1 PD72 Window Screen Configuration Window Screen Configuration Window Screen Configuration Window Screen Configuration 

 Sub windows  

Menu for executing commands 

Displays help on how to use windows and menus 

Displays status of execution of target program 

Toolbar with main command buttons Main display area 

Displays execution time of target program 
Displays status of break mode 
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1.1.21.1.21.1.21.1.2    PD72 Window ToolbarWindow ToolbarWindow ToolbarWindow Toolbar    
 
 

 

Break button 
Sets the position of the cursor in the 
window as the software breakpoint 

Go button 
 Executes target program 

Step button 
 One-step execution of target rogram

Return button 
 Runs the program up to 
 the higher routine 

SW button 
Sets a software breakpoint 

Come button 
Executes the target program 
from the value in the 
program counter to the 
position of the cursor in the 
window 

Stop button
Stops execution of the 
target program 

Reset button 
Resets the target program Over button 

Step over function/subroutine call 

HW button 
Sets a hardware breakpoint

BM button 
Change a break mode

 

1.1.31.1.31.1.31.1.3    PD72 Window Menu    
The menus in the PD72 Window can be classified as basic menus and extended menus. 
 

 

File menu 

Environment menu

View menu 

Edit menu 

Debugging menu 
(basic debugging) 

Debugging menu 
(optional items) 

Window menu 

Help menu 

 
Basic Menus and Extended MenusBasic Menus and Extended MenusBasic Menus and Extended MenusBasic Menus and Extended Menus 

The sub-menu items of the optional menus in PD72 automatically change according to 
which window is active in the main display area of the PD72 window. The optional 
menus are called extension menus. 

In contrast, the items on all menus other than the optional menus remain the same no 
matter which window is active. These are called basic menus, and provide the items for 
the basic operation of PD72 and debugging. 

Below, we look at the functions of each item on the basic menus. The functions of the 
items on the extended menus are described under the respective windows. 
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1.1.3.11.1.3.11.1.3.11.1.3.1    File operationFile operationFile operationFile operation    

The [File] menu in PD72 contains the items required for file operation such as including 
files, saving files, and terminating PD72. 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

File Download Download target program. - 
     Load Module...     Download machine language data and  

    debugging information. 
Shift + F.1 

     Memory Image...     Download only machine language data. - 
     Symbol...     Download only debugging information. - 
 Upload... Upload target program. - 
 Save Disasm... Save disassembly result. - 
 Exit Terminate PD72. - 
 
1.1.3.21.1.3.21.1.3.21.1.3.2    EditingEditingEditingEditing    

The [Edit] menu in PD72 contains the items required for editing operation such as 
character strings copy, paste, and search. 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

Edit Copy Copy character strings specified to clipboard. Ctrl + C 
 Paste Paste character strings of clipboard. Ctrl + V 
 Find... Find character strings. - 

 
1.1.3.31.1.3.31.1.3.31.1.3.3    DisplayDisplayDisplayDisplay    

The [View] menu in PD72 contains the items required for switching display of the tool bar 
and status bar. 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

View Tool Bar Switch display or non-display of tool bar. - 
 Status Bar Switch display or non-display of status bar. - 
 
1.1.3.41.1.3.41.1.3.41.1.3.4    SetupSetupSetupSetup    

The [Environ] menu in PD72 contains the items required for setting up the operating 
environment. 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

Environ Init... Environment setup - 
 Path... Source file search path - 
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1.1.3.51.1.3.51.1.3.51.1.3.5    Debugging (Basic)Debugging (Basic)Debugging (Basic)Debugging (Basic)    

The [Debug] menu in PD72 contains the items for basic debugging such as starting and 
stopping and one-step execution of the target program. 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

Debug Go Start target program. - 
     Go     Run from current program counter. F.1 
     Go Option...     Run from specified address. - 
 Come Run to cursor position. F.2 
 Step Step execution. - 
     Step     Execute one step. F.3 
     Step Option...     Execute specified No. of steps. - 
 Over Over-step execution. - 
     Over     Execute one over-step. F.4 
     Over Option...     Execute specified No. of over-steps. - 
 Return Execute until return from current subroutine. F.5 
 Break Point Set break point. - 
     S/W Break Point...     Open S/W Break Point Setting dialog box. F.7 
     H/W Break Point...     Open H/W Break Point Setting dialog box. Shift + F.7 
     Break     Set/cancel software break at cursor. - 
 Reset Reset target program. F.8 
 Stop Stop target program. - 
 Break Mode Change break mode. - 
 Trace Point... Set trace Point. - 
 Measurement Point... Set measurement Point. - 

 
1.1.3.61.1.3.61.1.3.61.1.3.6    Debugging (Option)Debugging (Option)Debugging (Option)Debugging (Option)    

The extended menus in PD72 contains the items for operating the various PD72 windows. 
The items on the extended menus differ according to which window is active. The 
functions of the items on the extended menus are described under the respective windows. 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

Option   (This menu contains the extended menus for 
the 
 various PD72 windows.) 

- 
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1.1.3.71.1.3.71.1.3.71.1.3.7    Window OperationsWindow OperationsWindow OperationsWindow Operations    

The [Window] menu contains the items for manipulating the display functions of the 
windows displayed by PD72. 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

Window Cascade Cascade windows. - 
 Tile Tile windows. - 
 Arrange Icon Arrange icons. - 
 Program Window Make Program Window active. - 
 Source Window Open Source Window. - 
 Register Window Open Register Window. - 
 Memory Window Open Memory Window. - 
 Dump Window  Open Dump Window. - 
 ASM Watch Window Open ASM Watch Window. - 
 Script Window Open Script Window. - 
 Trace Window Open Trace Window. - 
 Coverage Window Open Coverage Window. - 

 
1.1.3.81.1.3.81.1.3.81.1.3.8    HelpHelpHelpHelp    

The [Help] menu contains the items for displaying PD72 help messages and the PD72 
version No. 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

Help Index Display help. - 
 About... Display version information about PD72. - 
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1.21.21.21.2    Program WindowProgram WindowProgram WindowProgram Window    
The Program Window displays the machine code at the current program counter. The line 
at the program counter is highlighted in yellow. The Program Window is automatically 
opened in the main display area of the PD72 Window when you start PD72. The Program 
Window can be used for executing the target program up to the cursor position, set or 
cancel software breakpoints using the mouse, and displaying reverse assembles of the 
target program, etc. Double-click the software breakpoint display/setting area to set or 
cancel software breakpoints. 
 

1.2.11.2.11.2.11.2.1    Structure of Program WindowStructure of Program WindowStructure of Program WindowStructure of Program Window    
The Program Window has two display modes: source and disassemble. The structure of 
the Program Window is described for each display mode below. 
 
1.2.1.11.2.1.11.2.1.11.2.1.1    Structure of Program Window in Source Display ModeStructure of Program Window in Source Display ModeStructure of Program Window in Source Display ModeStructure of Program Window in Source Display Mode    

The source display mode is provided for debugging at the source level. You can check the 
source files of the target program in source display mode. 
 

       File name display  

SAMPLE PROGRAM

Source line 
display area 

Address display area 

Software breakpoint display/setting area 

Program display area 

Current program counter Toolbar 

 
 
z The line No. display area and address display area can be displayed or hidden by 

selecting or cancelling [Option] -> [Layout] -> [Line Area] and [Option] -> [Layout] 
-> [Address Area]. Note that, by default, the address display area is hidden. 

z Double-click the line No. display area to change the display source file. 
z Double-click the address display area to change the display starting address or the 

display starting line. 
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1.2.1.21.2.1.21.2.1.21.2.1.2    Structure of Program Window in Disassemble Display ModeStructure of Program Window in Disassemble Display ModeStructure of Program Window in Disassemble Display ModeStructure of Program Window in Disassemble Display Mode    

The disassemble display mode is provided for debugging at the instruction level. You can 
check the results of disassembling the target program in disassemble display mode. 
 

        

Object code display area Address display 
area 

Software breakpoint display/setting area Program display area 

Toolbar 

 
 
z The address display area and object code display area can be displayed or hidden by 

selecting or cancelling [Option] -> [Layout] -> [Address Area] and [Option] -> 
[Layout] -> [Code Area]. 

z Note that you cannot scroll backwards vertically until you have scrolled forwards. 
When you scroll forwards, the previous display address is stored in the internal 
buffer. This address information is used when you scroll backwards. 
Note that the internal buffer is cleared if you execute a command that changes the 
first line address. 

z If you disassemble an area (data or empty area, etc.) other than the program, the 
contents of memory are interpreted as instruction code and displayed in 
disassembled format. In this case, "???" is displayed for undefined instructions and 
operands. 

z Double-click the address display area to change the display starting address. 
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1.2.21.2.21.2.21.2.2    Program Window ToolbarProgram Window ToolbarProgram Window ToolbarProgram Window Toolbar    
 
        

View button 
Changes the part of the program being displayed. 
You can specify a source file, a function, an address, or the position of 
the program counter. 

 

SRC button 
Displays the program in source mode. 

DIS button 
Displays the program in disassemble mode. 

 

1.2.31.2.31.2.31.2.3    Extended menu in the Program WindowExtended menu in the Program WindowExtended menu in the Program WindowExtended menu in the Program Window    
When the Program Window is active in the PD72 main display area, the [Option] menu 
contains the following items: 
 
MenuMenuMenuMenu    Menu options Menu options Menu options Menu options     Function Function Function Function     Shortcut keysShortcut keysShortcut keysShortcut keys    

Option Font... Change font. - 
 TAB... Set source file display tabs. - 
 View Change contents of display. - 
     Source...     Display from specified source file or function. - 
     Address...     Display from specified address or line No. - 
     Program Counter     Display from current program counter. - 
 Mode Switch display mode. - 
     Source mode     Switch to source display mode. Ctrl + R 
     Disasm mode     Switch to disassemble display mode. Ctrl + R 
 Layout Set layout. - 
     Line Area     Turn on/off line No. area. - 
     Address Area     Turn on/off address area. - 
     Code Area     Turn on/off object code area. - 
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1.31.31.31.3    Source WindowSource WindowSource WindowSource Window    
The Source Window is provided for dedicated display of the program being checked. The 
line at the program counter is highlighted in yellow. In contrast to the Program Window, 
which follows the program counter, the Source Window is not updated until you specify. 
Use the Source Window to check what is happening in specific subroutines. You can open 
up to 10 Source Windows. Other functions are the same as in the Program Window. 
 

1.3.11.3.11.3.11.3.1    Structure of Source WindowStructure of Source WindowStructure of Source WindowStructure of Source Window    
The Source Window has two display modes: source and disassemble. The structure of the 
Source Window is described for each display mode below. 
The Source Window has the same structure as the Program Window. See Section 1.2.1, 
"Structure of Program Window" under Window Functions for details. 
 
1.3.1.11.3.1.11.3.1.11.3.1.1    Structure of Source Window in Source Display ModeStructure of Source Window in Source Display ModeStructure of Source Window in Source Display ModeStructure of Source Window in Source Display Mode    

The source display mode is provided for debugging at the source level. You can check the 
source files of the target program in source display mode. 
 

       File name display  

SAMPLE PROGRAM 

Source line 
display area 

Address display area 

Software breakpoint display/setting area 

Program display area 

Toolbar 
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1.3.1.21.3.1.21.3.1.21.3.1.2     Structure of Source Window in Disassemble Display Mode Structure of Source Window in Disassemble Display Mode Structure of Source Window in Disassemble Display Mode Structure of Source Window in Disassemble Display Mode    

The disassemble display mode is provided for debugging at the instruction level. You can 
check the results of disassembling the target program in disassemble display mode. 
 

        

Object code display area Address display 
area 

Software breakpoint display/setting area 
Program display area 

Toolbar 

 
 

1.3.21.3.21.3.21.3.2    Source Window ToolbarSource Window ToolbarSource Window ToolbarSource Window Toolbar    
The Source Window toolbar is the same as that in the Program Window. See Section 1.2.2, 
"Program Window Toolbar" under Window Functions for details. 
 

1.3.31.3.31.3.31.3.3    Extended Menus in the Source WindowExtended Menus in the Source WindowExtended Menus in the Source WindowExtended Menus in the Source Window    
When the Source Window is active in the PD72 main display area, extended menus for the 
Source Window are allocated to the [Option] menus. The extended menus of the Source 
Window are identical to those of the Program Window. See Section 1.2.3, "Extended menu 
in the Program Window" under Window Functions for details. 
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1.41.41.41.4    Register WindowRegister WindowRegister WindowRegister Window    
The Register Window shows the contents of the registers. The display is updated after 
each command is executed. You can click the buttons 
corresponding to registers in the Register Window to quickly change the values of the 
registers. 
 

1.4.11.4.11.4.11.4.1    Structure of Register WindowStructure of Register WindowStructure of Register WindowStructure of Register Window    
 

Program Counter 

A Register

B Register 

X Register 
Y Register 

Z Register 

Contents of RAM specified 
by data pointer 

Carry Flag 

 
 

 

 

Data Pointer 

 

1.4.21.4.21.4.21.4.2    Extended Menus in the Register WindowExtended Menus in the Register WindowExtended Menus in the Register WindowExtended Menus in the Register Window    
The Register Window is not exist the [Option] menu. 
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1.51.51.51.5    Memory WindowMemory WindowMemory WindowMemory Window    
The Memory Window displays the contents of contiguous memory in "address", "symbol", 
and "data (contents of memory)" formats. The display is updated after each command is 
executed. Data can be displayed in binary, decimal, and hexadecimal. You can open up to 
10 Memory Windows. You can use the Memory Windows to modify the contents of memory, 
and also to fill and move specified blocks of memory. 

1.5.11.5.11.5.11.5.1    Structure of Memory WindowStructure of Memory WindowStructure of Memory WindowStructure of Memory Window    
The Memory Window has two display modes: RAM and ROM. The diagrams below show 
the Memory Window's screen structures in the RAM display and the ROM display modes. 
 
1.5.1.11.5.1.11.5.1.11.5.1.1    Structure of Memory Window in RAM Display Structure of Memory Window in RAM Display Structure of Memory Window in RAM Display Structure of Memory Window in RAM Display ModeModeModeMode    

 

Toolbar 

Address display 
area 

Symbol display area

Data display area 

 
z Double-click the address display area to change the display RAM starting address. 
z Double-click a symbol or the memory display area to change the contents of 

memory. 
 
1.5.1.21.5.1.21.5.1.21.5.1.2    Structure of Memory Window in ROM Display ModeStructure of Memory Window in ROM Display ModeStructure of Memory Window in ROM Display ModeStructure of Memory Window in ROM Display Mode    

 

Toolbar 

Address display 
area 

Symbol display area

Data display area 

 



 
Window function of PD72 

 29

z Double-click the address display area to change the display ROM starting address. 
z Double-click a symbol or the memory display area to change the contents of 

memory. 
 

1.5.21.5.21.5.21.5.2    Memory Window ToolbarMemory Window ToolbarMemory Window ToolbarMemory Window Toolbar    
 
 Bin button 

Displays data in binary 

Displays data in decimal 

Hex button 
Displays data in hexadecimal (default) 

Dec button 
ROM button 

Displays data in ROM 

RAM button 
Displays data in RAM 

 
 

1.5.31.5.31.5.31.5.3    Extended Menus in tExtended Menus in tExtended Menus in tExtended Menus in the Memory Windowhe Memory Windowhe Memory Windowhe Memory Window    
When the Memory Window is active in the PD72 main display area, the [Option] menu 
contains the following items: 
 
Menu     Menu options     Function     Shortcut keys 

Option Font... Change font. - 
 View Change contents of display. - 
     Scroll Area...     Specify scroll range. - 
     Address...     Specify display starting address. - 
     Data Pointer     Change display start address to data pointer 

    position. 
- 

     Memory Area     Change display memory. - 
       Ram       Display in RAM - 
       Rom       Display in ROM - 
     Radix     Specify radix. - 
       Bin       Display in binary. - 
       Dec       Display in decimal. - 
       Hex       Display in hexadecimal. - 
     Refresh     Refresh display. - 
 Debug Set memory contents. - 
     Set...     Set data at specified address. - 
     Fill...     Fill specified memory block with data. - 
     Move...     Move specified memory block to specified 

    address. 
- 
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1.61.61.61.6    Dump WindowDump WindowDump WindowDump Window    
The Dump Window displays the contents of contiguous memory in dump format. The 
display is updated after each command is executed. You can open up to 10 Dump Windows. 
You can use the Dump Windows to modify the contents of memory, and also to fill and 
move specified blocks of memory. 
 

1.6.11.6.11.6.11.6.1    Structure of Dump WindowStructure of Dump WindowStructure of Dump WindowStructure of Dump Window    
The Dump Window has two display modes: RAM and ROM. The diagrams below show the 
dump Window's screen structures in the RAM display and the ROM display modes. 
 
1.6.1.11.6.1.11.6.1.11.6.1.1    Structure of Memory Window in RAM Display ModeStructure of Memory Window in RAM Display ModeStructure of Memory Window in RAM Display ModeStructure of Memory Window in RAM Display Mode    

 

Toolbar 

Address display area Data display area 
 

 
z Double-click the address display area to change the display RAM starting address. 
z Double-click the memory display area to change the contents of memory. 

 
1.6.1.21.6.1.21.6.1.21.6.1.2    Structure of Memory Window in RAM Display ModeStructure of Memory Window in RAM Display ModeStructure of Memory Window in RAM Display ModeStructure of Memory Window in RAM Display Mode    

 

Toolbar 

Address display area Data display area 

 
z Double-click the address display area to change the display RAM starting address. 
z Double-click the memory display area to change the contents of memory. 
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1.6.21.6.21.6.21.6.2    Dump Window ToolbarDump Window ToolbarDump Window ToolbarDump Window Toolbar    

 

RAM button 

Displays data in ROM 

Displays data in RAM 

ROM button 

 

1.6.31.6.31.6.31.6.3    Extended Menus in the Dump WindowExtended Menus in the Dump WindowExtended Menus in the Dump WindowExtended Menus in the Dump Window    
When the Dump Window is active in the PD72 main display area, the [Option] menu 
contains the following items: 
 
MenuMenuMenuMenu        Menu optionsMenu optionsMenu optionsMenu options        FunctionFunctionFunctionFunction        Shortcut keysShortcut keysShortcut keysShortcut keys    

Option Font... Change font. - 
 View Change contents of display. - 
     Scroll Area...     Specify scroll range. - 
     Address...     Specify display starting address. - 
     Memory Area     Change display memory. - 
       Ram       Display in RAM - 
       Rom       Display in ROM - 
     Refresh     Refresh display. - 
 Debug Set memory contents. - 
     Set...     Set data at specified address. - 
     Fill...     Fill specified memory block with data. - 
     Move...     Move specified memory block to specified 

    address. 
- 
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1.71.71.71.7    ASM Watch Window    
The ASM Watch Window allows you to check the values at any specified RAM address. 
You can specify the point to watch as an address (symbol or global variable), as an address 
and bit No., or as a bit symbol. The display is updated after each command is executed. 
 

1.7.11.7.11.7.11.7.1    Structure of ASMStructure of ASMStructure of ASMStructure of ASM Watch Window Watch Window Watch Window Watch Window    

 
Toolbar 

Address/Bit No. display area 

Expression display area

Data length display area 

Radix display area Data display area 

 
 
z The cursor position is indicated by a red mark in the address display area and data 

display area. Click either area or use the up cursor and down cursor keys to move 
the cursor. 

 
z Double-click the radix (Rdx) display area to switch the current radix for the data 

displayed in that area as follows:  
...  ->  hexadecimal  ->  decimal  ->  binary  ->  hexadecimal  ->  ... 

 
z Information about set watchpoints is stored in the Init file when you close the ASM 

Watch Window or exit PD72. When you re-open the ASM Watch Window, the 
previously set watch points are automatically restored. 

 
z In the case of the ASM Watch Window, the addresses of any previously set 

watchpoints are recalculated when you download a target program and the memory 
referenced using the new addresses. Thus there is no need to respecify the 
watchpoint addresses even when they change as a result of changes in the 
program. 

– When the addresses of inactive watchpoints (indicated by "--<not active>--") 
are recalculated and the result is a valid address, the watchpoints 
automatically become active again. 
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1.7.21.7.21.7.21.7.2    ASM Watch Window ToolbarASM Watch Window ToolbarASM Watch Window ToolbarASM Watch Window Toolbar    

 

 

Displays watch point in hexadecimal 

Add button 
Adds a watch point(address) 

Adds a watch point(bit) 

Sets specified watch point 

Deletes specified watch point 

Deletes all watch points 

Displays watch point in decimal 

Displays watch point in binary 
Hex button 

BitAdd button 

Del button 

Set button Dec button 

Bin button 

DelAll button 

 

1.7.31.7.31.7.31.7.3    Extended Menus in the ASM Watch WindowExtended Menus in the ASM Watch WindowExtended Menus in the ASM Watch WindowExtended Menus in the ASM Watch Window    
When the ASM Watch Window is active in the PD72 main display area, the [Option] menu 
contains the following items: 
 
MenuMenuMenuMenu        Menu optionsMenu optionsMenu optionsMenu options        FunctionFunctionFunctionFunction        Shortcut keysShortcut keysShortcut keysShortcut keys    

Option Font... Change font. - 
 Watch Register / delete watch point. - 
     Add...     Register watch point. Ctrl + A 
     Bitadd...     Register bit-level watch point. Ctrl + B 
     Set...     Set new data to be written to selected watch 

    point. 
Ctrl + S 

     Del     Delete selected watch point. Ctrl + D 
     DelAll     Delete all watch points. - 
 Radix Change display radix. - 
     Bin     Display value at selected watch point in 

    binary. 
Alt + B 

     Dec     Display value at selected watch point in 
    decimal. 

Alt + D 

     Hex     Display value at selected watch point in 
    hexadecimal. 

Alt + H 

 Layout Set layout. - 
     Address Area     Turn on/off address/bit area. - 
     Size Area     Turn on/off data size area. - 
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1.8 Script WindowScript WindowScript WindowScript Window 
The Script Window displays the execution of text-format script commands and the results 
of that execution. Script commands can be executed using a script file or interactively. You 
can also write script commands in the script file so that they are automatically executed. 
The results of script command execution can also be stored in a previously specified log 
file. 
 

1.8.11.8.11.8.11.8.1    Structure of Script WindowStructure of Script WindowStructure of Script WindowStructure of Script Window    
 
 

Toolbar 

Script file name display area Log file name display area 

Execution result display area Command input area 

Command history display area/Script file display area 
 

z The Script Window has a view buffer that stores the results of executing the last 
1000 lines. The results of execution can therefore be stored in a file (view file) 
without specifying a log file. 
 

z When a script file is opened, the command history area changes to become the 
script file display area and displays the contents of the script file. When script files 
are nested, the contents of the last opened script file are displayed. The script file 
display area shows the line currently being executed in inverse vide. 
 

z When a script file is open, you can invoke script commands from the command 
input area provided the script file is not being executed. 
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1.8.21.8.21.8.21.8.2    Script Window ToolbarScript Window ToolbarScript Window ToolbarScript Window Toolbar    

 

Step executes script file 

Executes script file 

Opens script file 

Closes script file 

Opens log file 

Closes log file 

Saves view buffer 

Clears view buffer 

Run button 

Open button 

Clear button 

LogOn button 

View button 

Step button 

Close button 

LogOff button

 

1.8.31.8.31.8.31.8.3    Extended Menus in the Script WindowExtended Menus in the Script WindowExtended Menus in the Script WindowExtended Menus in the Script Window    
When the Script Window is active in the PD72 main display area, the [Option] menu 
contains the following items: 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

Option Font.... Change font. - 
 Script Script file operations. - 
     Open...     Open script file. - 
     Run     Run script file. - 
     Stop     Stop execution of script file. - 
     Step     One-step execution of script file. - 
     Close     Close script file. - 
 View View buffer operations. - 
     Save...     Save view buffer file. - 
     Clear     Clear view buffer. - 
 Log Log file operations. - 
     On...     Open log file (start output to file). - 
     Off     Close log file (stop output to file). - 
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1.91.91.91.9    Trace WindowTrace WindowTrace WindowTrace Window    
The Trace Window displays the results of the realtime trace function (execution history) of 
the PC4400PC4400PC4400PC4400 emulator. The Trace Window supports the following three display modes, 
which are selected using the buttons on the Trace Window toolbar. 
 
z Bus mode 

Allows you to check bus data for each cycle. In bus mode, the trace contents are 
displayed following the execution path. The trace results can therefore be checked 
by scrolling using the vertical scrollbar. 

z Disassemble mode 
The executed instructions are displayed in disassembled format. In disassemble 
mode, the trace contents are displayed following the execution path. The trace 
results can therefore be checked by scrolling using the vertical scrollbar. 

z Source mode 
The execution paths can be searched for at the source line level. In source mode, 
the contents of the executed source file are displayed as-is (in contrast to being 
displayed following the execution path). The trace results can therefore be checked 
using the buttons on the toolbar. 

 
The Trace Window displays the results of the trace immediately the realtime trace is 
completed. Because the realtime trace is incomplete immediately after starting PDPDPDPD72727272 or 
immediately after running the target program, the Trace Window remains blank until the 
trace is completed. 
You can use trace points to specify when the trace starts and ends. Trace points are set via 
the Trace Point setting dialog box or using the Trace Point script command. If you do not 
specify any trace points (this is the default status), measurements end when execution of 
the target program breaks. Trace information is then displayed for the 4095 cycles prior to 
the break. 
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1.9.11.9.11.9.11.9.1    Screen Configuration in Bus ModeScreen Configuration in Bus ModeScreen Configuration in Bus ModeScreen Configuration in Bus Mode    

 

Toolbar 

Cycles display area 
Label display area 

Data bus information display area 

Current cycyles 

Range of the results of realtime trace 
Trace area

Address corresponded to cycles 

 
 
Toolbar 
In bus mode, only the display mode buttons (<BUS>, <DIS>, and <SRC>) are operative. 
However, if no debugging information has been downloaded, the <SRC> button is also 
inoperative. 
 
Cycles display area 
Displays the number of cycles per line. 
z The cycles are displayed in +/- decimals either side of the trace point (the cycle at 

which the realtime trace starts/ends: cycle 0). 
z You can double-click the cycles display area to change the No. of the cycle to be 

displayed. 
 
Data bus information display area 
This area shows the bus information for each cycle. From left to right, the contents are as 
follows: 
z Address 

Show the status of the address bus 
z Data 

Show the status of the data bus 
z Skip 

Show the status of the instruction skip. (skipped instruction is indicated by ‘1’) 
z Int 

Show the status of the interrupt. (interrupt is indicated by ‘1’) 
z 0123 

Shows the status of the 4-bit external signal (High level = "1", Low level = "0") 
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1.9.21.9.21.9.21.9.2    Screen Configuration in Disassemble ModeScreen Configuration in Disassemble ModeScreen Configuration in Disassemble ModeScreen Configuration in Disassemble Mode    

 

Address display area 

Status display area Label display area Disassemble display area 

Toolbar Current cycyles 

Range of the results of realtime trace 
Trace area 

Address corresponding to cycle area 

Object code display area Cycles display area 
 

 
Toolbar 
In disassemble mode, only the display mode buttons (<BUS>, <DIS>, and <SRC>) are 
operative. However, if no debugging information has been downloaded, the <SRC> button 
is also inoperative. 
 
Status display area 
Displays the number of status per cycle. 
z If a skip occurs, “Sk” is displayed to the left of Cycles display area. 
z IF an interrupt occurs “++++INTERRUPT” is displayed. 

 
Cycles display area 
Displays the number of cycles per line. 
z The cycles are displayed in +/- decimals either side of the trace point (the cycle at 

which the realtime trace starts/ends: cycle 0). 
z You can double-click the cycles display area to change the No. of the cycle to be 

displayed. 
 
Address display area 
Displays the Address per instruction in hexadecimal format. 
z You can search the address being displayed by double-clicking on the address 

display area. 
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1.9.31.9.31.9.31.9.3    Screen Configuration in Source MoScreen Configuration in Source MoScreen Configuration in Source MoScreen Configuration in Source Modededede    
 

 

Line No. display area Source file display area 

Toolbar Current cycyles 

Range of the results 

Trace area 

Name of source file Address corresponding to cycle area 

Reference cycle position display area 
Address display area  

 
Toolbar 
In source mode, all buttons on the toolbar except the [Come] button are available. 
The [Come] button is available when you click on a line in which a Come search can be 
performed. 
 
Line No. display area 
Displays the line No. in the source file. 
z The line No. display area can be displayed or hidden by selecting or cancelling 

[Option] -> [Layout] -> [Line Area]. 
z You can change the source file being displayed by double-clicking on the line area. 

 
Address display area 
Displays the Address per line in hexadecimal format. 
z The address display area can be displayed or hidden by selecting or cancelling 

[Option] -> [Layout] -> [Address Area].Note that, by default, the address display 
area is hidden. 

z You can search the address being displayed by double-clicking on the address 
display area. 

 
Reference cycle position display area 
Displays the current position when searching for an address from the trace data. 
z Displayed as ">>". This symbol moves when the search is continued. The hyphen (-) 

indicates a line with address information (Come searches can be performed on such 
lines). 

Note:Note:Note:Note:    
Although the instructions that would otherwise be skipped are traced when searching 
for execution paths, they are skipped correctly in actual operation.  
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1.9.41.9.41.9.41.9.4    Trace Window ToolbarTrace Window ToolbarTrace Window ToolbarTrace Window Toolbar    
 
 

SRC button 
 Switches to source mode 

DIS button 
 Switches to disassemble mode 

BUS button 
 Switches to bus mode 

Forward button 
 Specifies a forward search (*2) 

Step button 
 Searches the next trace path 

Com button 
 Searches specified line(s) 

*1 The Forward, Back, Step, and Come buttons are only effective in source display mode. 
*2 Forward searches trace the path in the order in which instructions are executed.  
Backward searches trace the path in the reverse order in which instructions were executed. 

(*1) 

Back button 
 Specifies a backward search (*2) 

 

1.9.51.9.51.9.51.9.5    Extended Menus in the Trace WindowExtended Menus in the Trace WindowExtended Menus in the Trace WindowExtended Menus in the Trace Window    
When the Trace Window is active in the PD72 main display area, the [Option] menu 
contains the following items: 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    ShorShorShorShortcut keystcut keystcut keystcut keys    

Option Font... Change font. - 
 TAB... Set tabs for source file display. - 
 View Change contents of display. - 
     Cycle...     Specify cycle. - 
     Address Search...     Search cycle by specifying address. - 
     Source...     Change by specifying source file. - 
 Mode Change display mode. - 
     Bus     Select bus mode. - 
     Disasm     Select disassemble mode. - 
     Source     Select source mode. - 
 Layout Set layout. - 
     Line Area     Turn on/off line No. area. - 
     Address Area     Turn on/off address area. - 
 Trace Search trace results. - 
     Forward     Search forward (in direction of execution). - 
     Backward     Search backward (in reverse direction of  

     execution). 
- 

     Step     Search one step (Step search). - 
     Come     Search specified line (Come search). - 
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1.101.101.101.10    Coverage WindowCoverage WindowCoverage WindowCoverage Window    
The Coverage Window is used to display the results of measurements performed by the 
coverage measurement function.  This window shows the coverage measurement result of 
a given address range in percentage.  

1.10.11.10.11.10.11.10.1    Structure of Script WindowStructure of Script WindowStructure of Script WindowStructure of Script Window    

 Tool bar 

Label display area 
Measurement range display area

Measurement result display area

   95.75% 0100      0121Sub1 
   00.00% 03F0      03FFdebug1 
  100.00% 0000      001FInit 

 
 
z The coverage measurement result of a given address range is displayed in 

percentage. 
 
z When you double-click on any desired line, a Coverage Source Window opens that 

allows you to check each source line to see if they have been executed or not. 
 
z The measurement result display area is changed to '--%' during target program 

execution. If you want to update the display, press the Refresh  button on the tool 
bar. 

 

1.10.21.10.21.10.21.10.2    Coverage Window ToolbarCoverage Window ToolbarCoverage Window ToolbarCoverage Window Toolbar    

 

Addarea button 
Set a range of addresses to be measured. 

Refresh button 
Update the coverage measurement result. 

Clear button 
Initialize the coverage measurement result. 

Delarea button 
Delete a specified range of measurement addresses. 
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1.10.31.10.31.10.31.10.3    Extended Menus in the Coverage WindowExtended Menus in the Coverage WindowExtended Menus in the Coverage WindowExtended Menus in the Coverage Window    
When the Coverage Window is active in the PD72 main display area, the [Option] menu 
contains the following items: 
 
MenuMenuMenuMenu    Menu optionsMenu optionsMenu optionsMenu options    FunctionFunctionFunctionFunction    Shortcut keysShortcut keysShortcut keysShortcut keys    

Option Font... Change font. - 
 Refresh Update the coverage measurement result. - 
 Clear Initialize the coverage measurement result. - 
 Add... Set a range of addresses to be measured. - 
 Del Delete a specified range of measurement  

addresses. 
- 

 Layout Set layout. - 
     Address Area     Turn on/off line Address area. - 
 



 
Window function of PD72 

 43

1.111.111.111.11    S/W Break Point Setting Dialog BoxS/W Break Point Setting Dialog BoxS/W Break Point Setting Dialog BoxS/W Break Point Setting Dialog Box    
The S/W Break Point Setting dialog box allows you to set software break points. Software 
breaks stop the execution of instructions immediately after the specified break point. You 
can also enable and disable each of those break points. 
 

1.11.11.11.11.11.11.11.1    Structure of S/W Break Point Setting Dialog BoxStructure of S/W Break Point Setting Dialog BoxStructure of S/W Break Point Setting Dialog BoxStructure of S/W Break Point Setting Dialog Box    

Field for specifying a break address,
if specifying an address

Fields for specifying filename + line No.
if specifying filename + line No.

Area for setting software break points

Adds a break point

Searches for filename

Closes dialog box

Deletes specified break point

Deletes all break points

Enables specified break point

Enables all break points

Disables specified break point

Disables all break points

 
 
z You can set up to 2 software break points in PD72. 
z If you have set multiple software breakpoints, program execution stops when any 

one software break address is encountered (OR conditions). 
z You can continue to set software breakpoints until you click the <Close> button to 

close the S/W BreakPoint setting dialog box. 
z You can clear, enable or disable software breakpoints selected by clicking in the 

software breakpoint display area. You can also enable and disable software 
breakpoints by double-clicking on them. 
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1.11.21.11.21.11.21.11.2    Entries in List of Software Break PointsEntries in List of Software Break PointsEntries in List of Software Break PointsEntries in List of Software Break Points    

 

Indicates if break point is enabled ("*" = disabled, " " = enabled) 

Break address 
Line No. at break address 

Filename for break address 

 
 
z If there is no source line, etc., for the address, only the address is displayed. 
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1.121.121.121.12    H/W Break Point Setting Dialog BoxH/W Break Point Setting Dialog BoxH/W Break Point Setting Dialog BoxH/W Break Point Setting Dialog Box    
The H/W Break Point Setting dialog box allows you to set hardware break points.  

1.12.11.12.11.12.11.12.1    Structure of H/WStructure of H/WStructure of H/WStructure of H/W Break Point Setting Dialog Box Break Point Setting Dialog Box Break Point Setting Dialog Box Break Point Setting Dialog Box    
In H/W ¥Break Point Setting Dialog Box, you can set two address breakpoints with pass 
counts and one trigger break point. You can also specify combinations of these three break 
points. 
The following shows the screen configuration for the H/W Break Point Setting Dialog Box . 
 

Address Event setting area 

Combination setting area 

Memory Event Status display area 

Trigger Event setting area 

Break condition setting area 

Timer setting area 

 
z For the address breakpoint setting area, breakpoint address can set up only point 

specification. 
z You can specify rising edge(High) or falling edge(Low) as trigger types for trigger 

breakpoints. 
z As combinations, you can specify that all specified break point conditions are 

satisfied(And), any one is satisfied(Or), or that they are satisfied in the order 
specified(Sequential). 
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z The break condition setup area is disabled, with the break conditions fixed to Break 
Point, which is one of the four break conditions listed below. 

 
Break Condition Contents 
Break Point Break occurs when a break point is reached. 
Stack Overflow Break occurs when the stack overflows or underflow. 
Trace Event Break occurs when there is a trace event. 
Trace Full Break occurs when write to trace memory has completed. 

 
z The timer setup area is disabled, with the timer operation modes fixed to NoUse, 

which is one of the four modes listed below. 
 

Timer Operation Contents 
NotUse Select this when no timer is used. 
TimeOut Trace event occurs when the break point is not reached within 

specified time. 
TimeCount Trace event occurs when the specified time has elapsed since the 

start of the program. 
DelayCount Trace event occurs when the specified time has elapsed since the 

break point is reached. 
 

Furthermore, although two count sources are available for the timer, the count 
sources are fixed to TIME and you cannot specify other count sources. 

 
Count Source Contents 
TIME(10us) The emulator timer(fixed at 10us) is used as the count source. 
CYCLE The MCU cycle is used as the count source. 
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1.131.131.131.13    Trace Point Setting DiTrace Point Setting DiTrace Point Setting DiTrace Point Setting Dialog Boxalog Boxalog Boxalog Box    
Use the Trace Point Setting dialog box to set trace points. The method for setting trace 
points is almost identical to setting break points in the H/W Break Point Setting dialog 
box. See section 1.12.1, “Structure of H/W Break Point Setting Dialog Box” for settings 
other than those discussed below. 
 

1.13.11.13.11.13.11.13.1    Structure of Trace Point Setting Dialog BoxStructure of Trace Point Setting Dialog BoxStructure of Trace Point Setting Dialog BoxStructure of Trace Point Setting Dialog Box    
The following describes only those points of the Trace Point Setting Dialog box screen 
configuration that differ from the H/W Break Point Setting dialog box. 
 
         

 

This area differs from the H/W

Break Point Setting dialog box. 

 
1.13.1.11.13.1.11.13.1.11.13.1.1    Setting the trace areaSetting the trace areaSetting the trace areaSetting the trace area    

The Trace Point Setting dialog box differs from the H/W Break Point Setting dialog box in 
that the break condition setting area (Break Mode) in the latter is a trace range setting 
area (Trace Range) in the former.  For the trace range setting area, you can specify a 
trace range with respect to a trace point.  The trace area to be stored in memory varies 
with the trace range specified here. 
 

Trace Area Contents 
Before Break Stores the 4K cycles (-4095 to 0 cycles) to the point at which the target 

program stops. 
Before Trace Stores the 4K cycles (-4095 to 0 cycles) to the point at which the trace 

point is passed. 
About Trace Stores the 2K cycles (-2048 to 2047 cycles) either side of the trace point. 
After Trace Stores the 4K cycles (0 to 4095 cycles) of trace data after the trace point. 
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1.141.141.141.14    Time Measurement point Setting Time Measurement point Setting Time Measurement point Setting Time Measurement point Setting Dialog BoxDialog BoxDialog BoxDialog Box    
The Time Measurement Point Setting dialog box is used to set a time measurement point. 

1.14.11.14.11.14.11.14.1    Structure of Time measurement Point Setting Dialog BoxStructure of Time measurement Point Setting Dialog BoxStructure of Time measurement Point Setting Dialog BoxStructure of Time measurement Point Setting Dialog Box    
 
       

Start address of measurement setting area 

Measurement count source setting area 

Measurement mode setting area 

End address of measurement setting area 

 
 
z Following four modes of time measurements are available to choose from. 

 
Measurement Mode Start Event End Event 
1. From Go to Break Start of program execution End of program execution 
2. From Go to MP End Start of program execution Measurement point End 
3. From MP Start to Break Measurement point Start End of program execution 
4. From MP Start to MP End Measurement point Start Measurement point End 

 
z Although there are following two count sources available for time measurement, 

the count sources are fixed to TIME and you cannot specify other count sources. 
 

Count Source Contents 
TIME Use the emulator's timer to measure time. 
CYCLE Use the target MCU cycles to measure time. 
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1. Loading and Displaying the Target Loading and Displaying the Target Loading and Displaying the Target Loading and Displaying the Target 
ProgramProgramProgramProgram 

1.11.11.11.1    DownloadingDownloadingDownloadingDownloading    
To download the target program, select the following from the PDPDPDPD72727272 Window: 
 [File] -> [Download] -> [Load module...] 
The File Selection dialog box opens. Select the target program from the File Selection 
dialog box.  The file to be downloaded is in the HEX files have the filename extension 
".HEX". 

You can also press Shift+F1 to open the File Selection dialog box for downloading files. 

1. Find the directory.

2. Double-click the file name.

 
Note: 

If you download the HEX file but the Program and Source Window does not switch to 
Source Program mode, the HEX file may not contain source line information. Check the 
options that you specified when assembling. 

 
To download only machine language data 

To download only machine language data, select the following from the PDPDPDPD72727272 Window 
menu:  

 [File] -> [Download] -> [Memory Image...] 
The File Selection dialog box opens. Select the HEX file, then download the machine 
language data. 

 
To download only symbol data 
To download only symbol data, select the following from the PDPDPDPD72727272 Window menu: 

 [File] -> [Download] -> [Symbol...] 
Select SYM file from the file Selection dialog box, then download the symbol data.  
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To reload the Target Program 
To reload a file, select the following from the PDPDPDPD72727272 Window menu: 

 [File] -> [Reload] 
The file is reloaded.  

 

1.2 UploadingUploadingUploadingUploading 
From the PDPDPDPD72727272 Window menu, select 
 [File]->[Upload...] 
to open the Upload dialog box. Enter the upload area and the name of the file to be saved.  

1. Specify the starting address.

2. Specify the end address.

Specify the name of the
file to be saved.

4. Click the "OK" button.

3.

 

1.3 Saving Results of DisasSaving Results of DisasSaving Results of DisasSaving Results of Disassemblysemblysemblysembly 
From the PDPDPDPD72727272 Window menu, select 
 [File]->[Save Disasm...] 
to open the Save Disasm dialog box. Enter the area to be saved and the filename. You can 
specify any filename and attribute. If you specify an existing filename, that file is 
overwritten. 

1. Specify the starting address.

2. Specify the end address.

Specify the name of the
file to be saved.

4. Click the "OK" button.

3.
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1.41.41.41.4    Continuing to Display a Selected Program PositionContinuing to Display a Selected Program PositionContinuing to Display a Selected Program PositionContinuing to Display a Selected Program Position    
The Program Window always displays the target program at the position of the program 
counter and you cannot, therefore, choose to always display the same position. You can do 
so, however, in the Source Window. To open the Source Window, select the following from 
the PDPDPDPD72727272 Window menu: 
 [Window]->[Source Window] 
 

1.51.51.51.5    CCCChanging the Program Display Positionhanging the Program Display Positionhanging the Program Display Positionhanging the Program Display Position    
You can display the source program in the Program Window and in the Source Window. 
To change the display position of the Program (or Source) Window, click on the "View" 
button in the toolbar of the Program (or Source) Window to open the Disp Area dialog box. 
You can only change the display position in the active window. 

View button

 
Click the "View" button to open the Disp Area dialog box. 

Source button
Change the File/Function
level

Change the
Address/Line No. level

Change the program counter

Address button

PC button

 
If no debugging information has been read in, no changes can be made at the file level, or 
at the line No. level. Further, if the Program (or Source) Window is in disassemble display 
mode, no changes can be made at the line No. level. 
 

Changing the display position at the file level 
Click the "Source" button in the Disp Area dialog box to open the Source dialog box. 
(The "Source" button cannot be clicked if no debugging information has been read in.) 
The Source dialog box shows the file structure of the downloaded target program. 
Click the name of the file to be changed. 

1. Select the file name.

2. Click the “OK” button.  
To open the Source dialog box, select the following from the PDPDPDPD72727272 Window menu: 
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 [Option]->[View]->[Source] 

You can also double-click the line No. display area of the Program (Source) Window 
to open the Source dialog box. 
 

Changing the display position at the address level 
Click the "Address" button from the Disp Area dialog box. Click the "Address" button 
to open the Disp Address dialog box. This dialog box is configured differently 
depending on the window's display mode. 

 
z Disassemble display mode 

If the display mode is the Disassemble mode, the Disp Address dialog box opens. 
Specify the address you want to be displayed in the input area and click the [OK] 
button. 

1. Specify the address.

2. Click the “OK” button.
 

z Source display mode 
If the display mode is the Source mode, the Address dialog box opens. After 
clicking the [Address] button, specify the address you want to be displayed in 
the input area and click the [OK] button. 

2. Specify the address.

3. Click the “OK” button.

1. Click the Address button.

 
To open the Disp Address dialog box, select the following from the PDPDPDPD72727272 Window 
menu: 
 [Option]->[View]->[Address...] 

You can also double-click the address display area of the Program (Source) Window 
to open the Disp Address(Address) dialog box. 
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Changing the display position at the line No. level 
When the Program (Source) Window is in source display mode, click the "Address" 
button from the Disp Area dialog box. Click the "Address" button to open the Address 
dialog box. Click the Line button in the Address dialog box to enter the new line No. 

2. Specify the line No.

3. Click the “OK” button.

1. Click the Line radio button.

 
 

To open the Address dialog box, select the following from the PDPDPDPD72727272 Window menu: 
 [Option]->[View]->[Address...] 

You can also double-click the address display area of the Program (Source) Window 
to open the Address dialog box. 

 
Changing the position of the program counter 
Click the "PC" button in the Disp Area dialog box. When you click the "PC" button, the 
display position changes to the position of the program counter. Change the position 
of the program counter, select the following from the PDPDPDPD72727272 Window: 

 [Option]->[View]->[Program Counter] 
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1.61.61.61.6    Checking Source ProgrChecking Source ProgrChecking Source ProgrChecking Source Programs in Other Directoriesams in Other Directoriesams in Other Directoriesams in Other Directories    
You can specify the search path for source files. This specification is valid when the target 
program's source files do not exist in the current directory. This function allows you to 
check these source files and set software breakpoints, etc., from the Program (or Source) 
Window. To open the Path dialog box and set the search path, select the following from 
the PDPDPDPD72727272 Window menu: 
 [Environ]->[Path...] 
To add a search path, click the "Add" button in the Path dialog box. The File Selection 
dialog box opens. Use the mouse to select the name of the file to be checked. 
 

1. Click the “Add" button.

3. Click the "OK" button.

2. Specify the search path in the File Selection dialog box.  
 

To delete a search path 
Open the Path dialog box, then carry out the following: 

 

1. Click the search path to be deleted.

2. Click the "Delete" button.

*Click "Delete All" to delete all search paths.

3. Click the "OK" button.
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1.71.71.71.7    Displaying the Results of DisassemblingDisplaying the Results of DisassemblingDisplaying the Results of DisassemblingDisplaying the Results of Disassembling    
To display the results of disassembling, click the "DIS" button on the Program (or Source) 
Window toolbar. The display mode can only be changed in the active window. 

DIS button
Switches to disassemble display mode.

SRC button
Switches to source display mode.

 
You can also select the following from the PDPDPDPD72727272 Window menu: 
 [Option]->[Mode]->[Disasm Mode] 
If, when the target program stops, the program counter is in an area with no source line 
data, the Program Window automatically switches to disassemble display mode. 
 

To revert from disassemble display to source program display mode 
Click the "SRC" button on the Program (or Source) Window toolbar. 
You can also switch to source program display mode by selecting the following from 
the PDPDPDPD72727272 Window menu: 

 [Option]->[Mode]->[Source Mode] 
 

Note: 
If there is no source line data in the first line in the program display area of the 
Program (or Source) Window, you cannot switch from disassemble display mode to 
source display mode(the "SRC" buttons are invalid). In this case, use the vertical 
scrollbar or Up/Down cursor keys to move the starting address of the program display 
area to a position where there is source line data. 
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2. Starting and Stopping Target ProgStarting and Stopping Target ProgStarting and Stopping Target ProgStarting and Stopping Target Program ram ram ram 
ExecutionExecutionExecutionExecution 

2.1 Starting and StoppingStarting and StoppingStarting and StoppingStarting and Stopping 
To start the target program 
Click the "Go" button on the PDPDPDPD72727272 Window toolbar. You can also press the "F1" key. 

 

Click the “Go” button.  
 

You can also start the target program by selecting the following from the PDPDPDPD72727272 
Window menu: 

 [Debug]->[Go] 

The target program runs until it reaches a breakpoint. 
 

Free-running the target program 
Execute the Go (G) command from the Script Window. Although the Go command 
basically executes a program with breaks included, the target program can be 
executed in free-running mode if breakpoints are omitted. For details of using script 
commands, see Section 9.1, "Executing Script Commands" in the Basic Operation 
part. 

 
Input format(Free Run):Input format(Free Run):Input format(Free Run):Input format(Free Run):    

Format 1: Go 
Format 2: Go starting_address 

 
Functions:Functions:Functions:Functions:    
z When no starting address is specified, runs the target program from the address 

currently indicated by the program counter (format 1); 
z Runs the target program from the specified starting address (format 2); 
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To stop the target program 
Click the "Stop" button on the PDPDPDPD72727272 Window toolbar. 

 

Click the “Stop” button.
 

 
You can also stop the target program by selecting the following from the PDPDPDPD72727272 
Window menu: 

 [Debug]->[Stop] 
 

Note: 
If, when the target program stops, the program counter is in an area with no source 
line data, the Program Window automatically switches to disassemble display mode. 

 
To start the target program from a specific address 
Select the following from the PD72 Window menu: 

 [Debug]->Go]->[Go Option...] 
The Go dialog box opens. Enter the starting address. 

 
To check if the target program is running 
The current execution status is displayed at the right end of the status bar in the 
PDPDPDPD72727272 Window. 

Target program is running.  
Target program is stopped.
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2.22.22.22.2    Step ExecutionStep ExecutionStep ExecutionStep Execution    
Click the "Step" button on the PDPDPDPD72727272 Window toolbar. Or press F3. 

Click the “Step” button.
 

 
When the Program Window is in source program mode, each line of the source program is 
executed, step by step. When the Program Window is in disassemble mode, each 
instruction is executed, step by step. 

You can also start step execution by selecting the following from the PDPDPDPD72727272 Window menu: 
 [Debug]->[Step]->[Step] 

 
To execute subroutines as single instructions in step mode 
Executing subroutines as single instructions in step mode is called as over-step 
execution. Click the "Over" button on the PDPDPDPD72727272 Window toolbar. Or press F4. 

Click the “Over” button.
 

You can also start over-step execution by selecting the following from the PDPDPDPD72727272 
Window menu: 

 [Debug]->[Over]->[Over] 
 

To specify the time of steps 
Select the following from the PDPDPDPD72727272 Window menu: 

 [Debug]->[Step]->[Step Option...] 
 (For over-step execution, select [Debug]->[Over]->[Over Option...].) 

Specify the time of steps in the displayed Step (or Over) dialog box. 
 

To stop step execution 
Click the "Stop" button on the toolbar. You can also stop step execution by selecting 
the following from the PDPDPDPD72727272 Window menu: 

 [Debug]->[Stop] 
This also applies to over-step execution. 
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2.32.32.32.3    Returning from Current to Calling RoutineReturning from Current to Calling RoutineReturning from Current to Calling RoutineReturning from Current to Calling Routine    
Click the "Return" button on the PDPDPDPD72727272 Window toolbar (called as Return execution). You 
can also press F5. 

Click the “Return” button.
 

You can also return to a calling routine by selecting the following from the PDPDPDPD72727272 Window 
menu: 
 [Debug]->[Return] 
 

To stop return execution 
Click the "Stop" button on the toolbar. You can also stop return execution by selecting 
the following from the PDPDPDPD72727272 Window menu: 

 [Debug]->[Stop] 
 

2.42.42.42.4    Program Execution to SpeciProgram Execution to SpeciProgram Execution to SpeciProgram Execution to Specified Locationfied Locationfied Locationfied Location    
To run the target program to the specified position (known as Come Execution), first click 
the line at which you want the program to stop in the program display area of the 
Program (Source) Window to specify the cursor position. Note, however, that Come 
Execution cannot be carried out if the cursor is positioned on a line in which no software 
breakpoint can be set (comment lines, and data definition lines, etc.). 

Cursor position set by clicking the mouse.
 

To start Come execution, click the "Come" button on the PDPDPDPD72727272 Window toolbar. You can 
also press F2. 

Click the “Come” button.
 

 
You can also start Come execution by selecting the following from the PDPDPDPD72727272 Window 
menu: 

 [Debug]->[Come] 
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Note: 
In Come execution, the breakpoints specified for software and hardware breaks are 
ignored. 
 

To stop come execution 
Click the "Stop" button on the toolbar. You can also stop Come execution by selecting 
the following from the PDPDPDPD72727272 Window menu: 
 [Debug]->[Stop] 

 

2.52.52.52.5    Resetting the ProgramResetting the ProgramResetting the ProgramResetting the Program    
To reset the target program, click the "Reset" button on the PDPDPDPD72727272 Window toolbar. You 
can also press F8. 
 

Click the “Reset” button.  
 
You can also reset the target program by selecting the following from the PDPDPDPD72727272 Window 
menu: 

 [Debug]->[Reset] 
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3. Software BreaksSoftware BreaksSoftware BreaksSoftware Breaks 

Use a software break to break target program execution at a specified line (address). Use 
the S/W Break Point Setting dialog box to set a software break point. When you set a 
software break, execution of the target program stops immediately before the software 
break point. 
 
z You can set up to 2 software break points. 
z If you set multiple software break points, the target program stops as soon as 

execution reaches any of the software break addresses. 
 

3.13.13.13.1    Enabling S/W BreaksEnabling S/W BreaksEnabling S/W BreaksEnabling S/W Breaks    
Click the [BM] button on the PDPDPDPD72727272 window's tool bar to change the break mode to "S/W 
break." The [BM] button toggles between "S/W break" and "H/W break." 

Click the “BM” button.
 

If the current break mode is "S/W break," you will find that the break mode shown in the 
right part of the PDPDPDPD72727272 window's status bar is changed as follows: 

 
The break mode can also be switched over using the following commands on the PDPDPDPD72727272 
window menu: 

[Debug] -> [Break Mode] 
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3.23.23.23.2    Opening the S/Opening the S/Opening the S/Opening the S/W Break Point Setting Dialog BoxW Break Point Setting Dialog BoxW Break Point Setting Dialog BoxW Break Point Setting Dialog Box    
Click the "SW" button on the PDPDPDPD72727272 Window toolbar. Press function key F7 to open the 
software breakpoint setting dialog box. 
 

Click the “SW” button.
 

 
You can also open the S/W Break Point Setting dialog box by selecting the following from 
the PDPDPDPD72727272 Window menu: 

 [Debug]->[Break Point]->[S/W Break Point...] 

See Section 1.11, "S/W Break Point Setting Dialog Box" in the Introduction for the 
structure of the S/W Break Point Setting dialog box. 
 

3.33.33.33.3    Setting a Break PointSetting a Break PointSetting a Break PointSetting a Break Point    
 

To specify an address as a break point 
In the S/W Break Point Setting dialog box, specify an address or label in the Address 
field, as follows: 

 

4.Click the "Close" button.

2. Specify the address.

1. Click the "Address" button.

3.Click the "Add" button.
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To specify a line No. as a break point 
In the S/W Break Point Setting dialog box, specify a filename and a line No, as 
follows: 

 
           

4. Click the "Add" button.

5. Click the "Close" button.

2. Specify the filename.

1. Click the "Filename" button.

3. Specify the line No.

 

3.43.43.43.4    Deleting a Break PointDeleting a Break PointDeleting a Break PointDeleting a Break Point    
In the S/W Break Point Setting dialog box, delete the break point as follows: 
 

 

2. Click the "Del" button.

3. Click  the "Close" button.

1. Click the break point to be deleted.

* Click "Del All" to delete all break points.
 

You can also click the breakpoint to be deleted, then press the Delete key. 
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3.53.53.53.5    Temporarily Disabling Break PointsTemporarily Disabling Break PointsTemporarily Disabling Break PointsTemporarily Disabling Break Points    
In the S/W Break Point Setting dialog box, disable the break point as follows: 
 

 

2. Click the"Disable" button.

3. Click the "Close" button.

1. Click the break point to be disabled.

* Click "All Disable" to disable all break points.

 
You can also double-click the breakpoint to be disabled. (An asterisk (*) is displayed). 
 

3.63.63.63.6    Temporarily Enabling Break PointsTemporarily Enabling Break PointsTemporarily Enabling Break PointsTemporarily Enabling Break Points    
In the S/W Break Point Setting dialog box, enable the break point as follows: 
 

2. Click the "Enable" button.

3. Click the "Close" button.

1. Click the break point to be enabled.

* Click "All Enable" to enable all break points.

 
You can also double-click the breakpoint to be enabled. (An asterisk (*) is deleted). 
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3.73.73.73.7    Setting a Break Point from Program (Source) WindowSetting a Break Point from Program (Source) WindowSetting a Break Point from Program (Source) WindowSetting a Break Point from Program (Source) Window    
You can also set break points in the Program or Source Window. To do so, double-click the 
break point setting display area (BRK column) (indicated by "-") for the line in which you 
want to set the break. 
 

Double-click here.
 

Lines in which a software break point have been set are marked by a "B" in place of the"-" 
in the break point setting display area (BRK column). You can delete the break point by 
double-clicking again in the BRK column. 
 

3.83.83.83.8    Setting Breakpoints from the ToolbarSetting Breakpoints from the ToolbarSetting Breakpoints from the ToolbarSetting Breakpoints from the Toolbar    
You can set breakpoints from the toolbar in the PDPDPDPD72727272 Window. In the Program (Source) 
Window, click the program display area of the line in which you want to set the break 
(lines for which "-" is displayed in the corresponding breakpoint display area). 

To set the breakpoint, click the "Break" button in the PDPDPDPD72727272 Window toolbar. 
 

Click the “Break” button.
 

 
You can also set a breakpoint by selecting the following from the PDPDPDPD72727272 Window menu: 

 [Debug]->[Break Point]->[Break] 

The mark on the lines set as software breakpoints changes from "-" to "B" in the 
breakpoint display area of the window. You can cancel a software breakpoint by again 
clicking the line indicated by "B" then clicking the "Break" button. 
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4. Hardware BreaksHardware BreaksHardware BreaksHardware Breaks 

Use hardware breaks to break target program execution when memory is accessed. There 
are two types of hardware breaks: an address break where a break occurs when execution 
of a specified address (Fetch) is detected and a trigger break where a break occurs when 
the rising or falling edge of a signal input from an external trace cable is detected.  
Address and trigger breaks can be used in combination.  
The method of setting hardware break points differs according to the emulator you are 
using. See section 1.12.1, "Structure of H/W Break Point Setting Dialog Box" for settings 
other than those discussed below. 
 

4.14.14.14.1    Enabling H/W BreaksEnabling H/W BreaksEnabling H/W BreaksEnabling H/W Breaks    
Click the [BM] button on the PDPDPDPD72727272 window's tool bar to change the break mode to "H/W 
break." The [BM] button toggles between "S/W break" and "H/W break." 

Click the “BM” button.
 

If the current break mode is "H/W break," you will find that the break mode shown in the 
right part of the PDPDPDPD72727272 window's status bar is changed as follows: 

 
The break mode can also be switched over using the following commands on the PDPDPDPD72727272 
window menu: 

[Debug] -> [Break Mode] 
 

4.24.24.24.2    OpeniOpeniOpeniOpening the H/W Break Point Setting Dialog Boxng the H/W Break Point Setting Dialog Boxng the H/W Break Point Setting Dialog Boxng the H/W Break Point Setting Dialog Box    
Click the "HW" button on the PDPDPDPD72727272 Window toolbar. Press function key Shift + F7 to open 
the hardware breakpoint setting dialog box. 
 

Click the “HW” button.  
You can also open the H/W Break Point Setting dialog box by selecting the following from 
the PDPDPDPD72727272 Window menu: 
 [Debug]->[Break Point]->[H/W Break Point...] 
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4.34.34.34.3    Setting Address Breakpoints Setting Address Breakpoints Setting Address Breakpoints Setting Address Breakpoints     
The PC4400PC4400PC4400PC4400 emulator allows you to set two address breakpoints. 
 

Setting an Address Break Point 
To set an address break point, click on any of buttons "A1" to "A2" in [Address Event] 
group in the H/W Break Point Setting dialog box to open the Address Break Point 
Setting dialog box, then set the address break point. 

 
After setting an address breakpoint, click the [OK] button in the H/W Break Point 
Setting dialog box to enable the hardware break you have set. 

 
 

To break execution on fetching a command at the specified address 
The following shows how to set a break point for the third time the command at 
address "10016" is fetched. 

 1.Click the “Point”button. 

2.Specify the Address “100”. 

3.Specify the Pass Count “1”. 

4.Click the OK button. 
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4.44.44.44.4    To set a trigger break pointTo set a trigger break pointTo set a trigger break pointTo set a trigger break point    
The PC4400PC4400PC4400PC4400 emulator allows you to set one trigger breakpoint. Before using a trigger 
break, prepare an external trace cable. A trigger signal is taken in from this cable.  
 

To set a trigger break point 
The following shows a setting example where a break occurs at a rising edge of the 
input signal (High). Use the H/W Breakpoint Setting dialog box to enter this setting. 

 
 

1.Click the “High”button.

2.Specify the Pass Count “1”.
 

4.54.54.54.5    To combination break pointTo combination break pointTo combination break pointTo combination break point    
There are three combinatorial conditions that can be specified.  These include "And" 
where a break occurs when all conditions are met, "Or" where a break occurs when one of 
conditions is met, and "Sequential" where a break occurs when conditions are set in a 
specified sequence.  Use Combination Type in the H/W Break Point Setting dialog box to 
set these combinatorial conditions. 
 

To enable a break point (one only) 
The following shows a setting example where only address breakpoint A1 is enabled. 

 
1.Click the “And”button. 

2.Click the “A1”button. 

3.Click the “None”button. 

 
To combine break points 
You can specify any of three types of combination: when all conditions for the 
specified break point are satisfied (And), when any one is satisfied (Or), or when they 
are satisfied in the specified order (Sequential). 

 
1.Specify combinatorial condition. 

2.Click the 1st break point. 

3.Click the 2nd break point 
  (or check "None" if none is to be used). 

4.Click the 3rd break point 
  (or check "None" if none is to be used).  
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5.5.5.5.    Real Time TracingReal Time TracingReal Time TracingReal Time Tracing    

In PDPDPDPD72727272, you can check the trace results using any of three display modes: bus mode in 
which you can check the bus data each cycle, disassemble mode, in which executed 
instructions are disassembled for display, and source mode, in which executed instructions 
are displayed at the source line level. The trace results are shown in the Trace Window. 
To open the Trace Window, select  
    [Trace Window] -> [Window] 
in the menu in the PDPDPDPD72727272 window. 
 

5.15.15.15.1    To check bus data each cycleTo check bus data each cycleTo check bus data each cycleTo check bus data each cycle    
Click the "BUS" button on the toolbar in the Trace Window to switch to bus display mode. 
 

Click "BUS" to change to bus mode.

 
 
Use the Up and Down cursor keys, the Page Up and Page Down keys, or scroll using the 
vertical scroll bar to check the bus data outside the displayed cycle. See Section 1.9.1 
“Screen Configuration in Bus Mode” in the Window function for details of bus mode. 
 

To change the reference position by specifying the trace cycle 
Double-click the cycles area in the Trace Window to open the Cycle dialog box. 
Input the number of cycles. You can also open the Cycle dialog box from the PDPDPDPD72727272 
Window menu: 

 [Option]->[View]->[Cycle] 
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To search for a specified address 
Double-click the address area in the Trace Window to open the Address Search 
dialog box. Input the address to search. You can also open the Address Search 
dialog box from the menu in the PDPDPDPD72727272 Window: 

 [Option]->[View]->[Address Search] 
 

To check the status of the external signal 
Connect the external trace signal cable supplied with the PC4400PC4400PC4400PC4400 emulator. The 
status of the external signal is displayed in the "0123" area of the Trace Window. 

 

5.25.25.25.2    To check executed InstructionsTo check executed InstructionsTo check executed InstructionsTo check executed Instructions    
Click the "DIS" button on the toolbar in the Trace Window to switch to disassemble 
display mode. 

 

Click "DIS" to change to disassemble mode. 

 
 

Use the Up and Down cursor keys, the Page Up and Page Down keys, or scroll using the 
vertical scroll bar to check the disassemble data outside the displayed area. 
 

To change the reference position by specifying the trace cycles 
Double-click the cycles area in the Trace Window to open the Cycle dialog box. 
Input the number of cycles. You can also open the Cycle dialog box from the PDPDPDPD72727272 
Window menu: 

 [Option]->[View]->[Cycle] 
 

To search for the cycle in which an operation code was fetched to a 
specified address 

Double-click the address area in the Trace Window to open the Address Search 
dialog box. Input the address to search. You can also open the Address Search 
dialog box from the menu in the PDPDPDPD72727272 Window: 

 [Option]->[View]->[Address Search] 
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5.35.35.35.3    To check execution path at tTo check execution path at tTo check execution path at tTo check execution path at the source levelhe source levelhe source levelhe source level    
Click the "SRC" button on the toolbar in the Trace Window to switch to source display 
mode. 

Click "SRC" to change to source mode. 

 
 

Click the "Back" button on the toolbar in the Trace Window to check the execution path in 
reverse direction, then click the "Step" button. Or click the "Forward" button on the 
toolbar in the Trace Window to check the execution path in the forward direction, then 
click the "Step" button. 
 
 

Click to display the execution path in the reverse direction. 

Click to display the execution path in the forward direction. 

Click to check the following execution route as specified by clicking 
 the Forward or Backward button.  

 
To change the reference position by specifying the trace cycles 

Double-click the cycles area in the Trace Window to open the Cycle dialog box. 
Input the number of cycles. You can also open the Cycle dialog box from the PDPDPDPD72727272 
Window menu: 

 [Option]->[View]->[Cycle] 
 

To search for the cycle in which an operation code was fetched to a 
specified address 

Double-click the address area in the Trace Window to open the Address Search 
dialog box. Input the address to search. You can also open the Address Search 
dialog box from the menu in the PDPDPDPD72727272 Window: 

 [Option]->[View]->[Address Search] 
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To search for the cycle in which an operation code was fetched to a secific 
source line 

Click the mouse on a source line in the source file area in the Trace Window, then 
click the "Come" button to start the search. The search is performed in the direction 
currently specified as the execution path ("Forward" for forward searches, and 
"Back" for backward searches).  

Click to search in the Backward direction. 

Click to search for a source line execution cycle. 

Click to search in the Forward direction. 

 

5.45.45.45.4    Changing the RealChanging the RealChanging the RealChanging the Real----Time Trace Position to beTime Trace Position to beTime Trace Position to beTime Trace Position to be Saved Saved Saved Saved    
PDPDPDPD72727272 stores the results of real-time traces of target programs. By default, the trace range 
is the 4K cycles to just before the target program stops (Break). However, PDPDPDPD72727272 also 
allows you to specify the 4K cycles up to satisfaction of the trace point condition (Before), 
the 2K cycles centered on the satisfaction of the trace point condition (About), or the 4K 
cycles after the satisfaction of the trace point condition (After). In this case, the trace point 
is, like the hardware break point, the point at which real-time trace are performed when 
the system detects that data is written to memory, read from memory, or an instruction is 
fetched, or detects the rising or falling edge of the signal input from the external trace 
cable. 
 

Setting a Trace Point 
To set a trace point, open the Trace Point Setting dialog box by selecting  
    [Trace Point] ->  [Debug]  
from the menu in the PDPDPDPD72727272 Window. 
For details on how to set trace points, Section 4, "Hardware Break" in the basic 
operation part of this manual. 

Note: 
The basic setup method is the same as for hardware breakpoints, except the following. 
• Only the address A1 can be set. You cannot set the address A2. 
• No pass counts can be set for the address trace points set. 
• No combinatorial trace points are supported. (Only A1 or T can be selected.) 

 
Setting the Trace Area 

To change the trace area, change the setting in the "Trace Area" group in the Trace 
Point Setting dialog box. 

     

Select the trace Area 

1. Break 4Kcycles before target program stops 

2. Before 4K cycles before trace point 

3. About 2K cycles either side of trace point 

4. After 4K cycles after trace point 
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6. Time Measurement Time Measurement Time Measurement Time Measurement  

Use the time measurement function to measure the target program's execution time. The 
measured execution time of the target program is displayed on the status bar of the PDPDPDPD72727272 
window. Time measurement points are set from the Time Measurement Point Setting 
dialog box. 
The default time measurement mode is "1. From Go to Break" in which a duration of time 
from start of execution till end of execution is measured. The measurement count source is 
"TIME," i.e., the PC4400PC4400PC4400PC4400's internal timer is used to measure a time. The Time 
Measurement Point Setting dialog box is opened by choosing the following commands 
from the PDPDPDPD72727272 window menu: 
[Debug] -> [Measurement Point...] 

6.16.16.16.1    Checking Program Execution TimeChecking Program Execution TimeChecking Program Execution TimeChecking Program Execution Time    
The measured execution time of the target program is displayed on the status bar of the 
PD72 window.  The contents displayed here are updated when the target program has 
stopped.  

Display the target program's execution time (TIME mode).  
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6.26.26.26.2    Measuring Execution Time of A Selected Address RangeMeasuring Execution Time of A Selected Address RangeMeasuring Execution Time of A Selected Address RangeMeasuring Execution Time of A Selected Address Range    
Enter the following settings from the Time Measurement Point Setting dialog box: 

4.Click the “OK” button.

2.Specify the measurement start address. 

1.Change the measurement mode to  
  "4. From MP Start to MP End." 

3.Specify the measurement end address. 

 
To use a debug event as a time measurement point 

The PC4400PC4400PC4400PC4400 emulator has the following four modes of time measurements available. 
To switch over the time measurement modes, change the Mode area in the Time 
Measurement Point Setting dialog box to your desired mode. 

 
No. Measurement Mode Start Event End Event 
1. From Go to Break Start of program execution End of program execution 
2. From Go to MP End Start of program execution Measurement point End 
3. From MP Start to Break Measurement point Start End of program execution 
4. From MP Start to MP End Measurement point Start Measurement point End 

 
If you selected No. 3 or 4 for the measurement mode number, you need to specify a 
start address of measurement in the MP Start area of the Time Measurement Point 
Setting dialog box.  Or if you selected No. 2 or 4 for the measurement mode 
number, you need to specify an end address of measurement in the MP End area of 
the dialog box. 

    
Note:Note:Note:Note: 
If "End of program execution" is chosen for the end of measurement point, measurement 
is taken of time until execution of the broken instruction is ended.  In all other cases, 
measurement is taken of time until conditions are met for the end of measurement event. 
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7. Checking and Setting Register DataChecking and Setting Register DataChecking and Setting Register DataChecking and Setting Register Data 

7.17.17.17.1    Checking the Contents of RegistersChecking the Contents of RegistersChecking the Contents of RegistersChecking the Contents of Registers    
Open the Register Window to check the contents of the registers. The Register Window, 
which lists the internal registers of the CPU that are common to MCU’s, is opened from 
the PDPDPDPD72727272 Window menu by selecting the following: 
 [Window]->[Register Window] 

See Section 1.4, "Register Window" in the Window Functions for details of the Register 
Window. 
 

7.27.27.27.2    Setting the Contents of RegistersSetting the Contents of RegistersSetting the Contents of RegistersSetting the Contents of Registers    
To set the contents of the registers, click the register buttons in the Register Window to 
open the Register dialog box, then input the new value. 
 
 

 
To change the values of flags 

The Set Register dialog box does not open if you clicked the [CY] button of the 
Register Window. The value of the carry flag changes each time you click the [CY] 
button. 
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8. Checking and Setting Memory ContentsChecking and Setting Memory ContentsChecking and Setting Memory ContentsChecking and Setting Memory Contents 

8.1 Checking the Value at a Specified AddressChecking the Value at a Specified AddressChecking the Value at a Specified AddressChecking the Value at a Specified Address 
Use the watch function to check the value at a specified address. Check the value at the 
specified address in the ASM Watch Window. The address is called as the watch point. To 
open the ASM Watch Window, select the following from the PDPDPDPD72727272 Window menu: 
 [Window]->[ASM Watch Window] 
See Section 1.7, "ASM Watch Window" in the Window Functions for details of the ASM 
Watch Window. 

 
To register a watch point 

Click the "Add" button in the menu bar in the ASM Watch Window to open the Add 
dialog box. Input the address to monitor. 

 

1. Click the “Add” button to open the following dialog box.

2. Specify the address to monitor.

3. Select the data size.

4. Select the data radix.

5. Click the "OK" button.

 
 

The registered watchpoint is added at the current cursor position in the ASM 
Watch Window. The cursor position is indicated by a red mark in the address 
display area and data display area. You can move the cursor by clicking on either 
area or using the Up  and Down  keys. 

 



Checking and Setting Memory Contents 

 79

To register a specific bit as a watch point  
Click the "BitAdd" button in the menu bar in the ASM Watch Window to open the 
BitAdd dialog box. Input the bit symbol or the address and bit No. to monitor. 

 

1. Click the “BitAdd” button to open the following dialog box.

2. Specify the bit symbol. If none has

3. Click the "OK" button.

been defined, Specify the address
and bit No. in the next fields.

 
 

To change the value at a specified address 
Select the watch point to change in the ASM Watch Window, then click the "Set" 
button on the toolbar of the ASM Watch Window. 

 
2. Click the "Set" button.

1. Click the watch point to be changed.
 

 
The Set dialog box opens. Enter the new value. 
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To delete a watch point 
Select the watch point to be deleted in the ASM Watch Window, then click the "Del" 
button on the toolbar of the ASM Watch Window. 

 
2. Click the "Del" button.

1. Click the watch point to be deleted.

* To delete all watch points, click the “DelAll” button.
 

 
You can also click the watch point to be deleted, then press the Delete key. 

 
To change the memory display format  

You can change the radix in which data is displayed to select the watch point to be 
changed in the ASM Watch Window, then clicking "Hex", "Dec", or "Bin" in the 
toolbar of the ASM Watch Window. 

 
 Click to display in Hexadecimal 

Click to display in Binary 

Click to display in Decimal 
 

 
You can also double-click the radix display area in the ASM Watch Window. In this 
case, the radix changes cyclically in order of the following: 
  Hexadecimal  ->  Decimal  ->  Binary  ->  Hexadecimal 

 



Checking and Setting Memory Contents 

 81

8.28.28.28.2    To reference the contents of contiguous addressesTo reference the contents of contiguous addressesTo reference the contents of contiguous addressesTo reference the contents of contiguous addresses    
To reference the contents of contiguous addresses, open the Memory or Dump Window.  
The Memory Window displays contiguous memory contents in the form of "Address," 
"Symbol," or "Data (memory contents)."  The Dump Window displays contiguous memory 
contents in dump form.  In either case, RAM contents are displayed by default. 
To use the Memory Window, select the following from the PDPDPDPD72727272 Window menu: 
 [Window]->[Memory Window] 
To use the Dump Window, select the following from the PDPDPDPD72727272 Window menu: 
 [Window]->[Dump Window] 
See Section 1.5, "Memory Window" in the Window Functions for details of the Memory 
Window, and Section 1.6, "Dump Window" in the Window Functions for details of the 
Dump Window. 
 

To reference a ROM address 
Click the [ROM] button on the Memory or Dump Window tool bar. 

Click the ROM button.  
 

To reference a RAM address 
Click the [RAM] button on the Memory or Dump Window tool bar. 

Click the RAM button.  

8.38.38.38.3    Setting Data at a Specified AddressSetting Data at a Specified AddressSetting Data at a Specified AddressSetting Data at a Specified Address    
Data can be set a specified address from the Memory or Dump Window.  The type of 
memory to which data is set depends on the current display mode of the active window.  
Data is set to RAM memory when the display mode is RAM or ROM memory when the 
display mode is ROM. 
 

To change data at a specified address 
With the Memory Window or Dump Window active, select the following from the 
PDPDPDPD72727272 Window menu: 
 [Option]->[Debug]->[Set...] 
When the Set dialog box opens, enter the address to be changed and the new data. 

2. Specify the new data.
1. Specify the address.

3. Click the "OK" button.
 

You can also double-click the data display area in the Memory Window or Dump 
Window to open the Set dialog box. 
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To fill a specified area with data 
With the Memory Window or Dump Window active, select the following from the 
PDPDPDPD72727272 Window menu: 
 [Option]->[Debug]->[Fill...] 
When the Fill dialog box opens, enter the area to be filled and the fill data. 

 

3. Specify the fill data.
2. Specify the ending address of the area to be filled.
1. Specify the starting address of the area to be filled.

4. Click the "OK" button.

 
 

To move the contents of a specified area to another area 
With the Memory Window or Dump Window active, select the following from the 
PDPDPDPD72727272 Window menu: 
 [Option]->[Debug]->[Move...] 
When the Move dialog box opens, enter the starting and ending addresses of the 
source area and the starting address of the destination area. 

 

3. Enter the starting address of the destination.
2. Enter the ending address of the source area.
1. Enter the starting address of the source area.

4. Click the "OK" button.
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9. Script CommandsScript CommandsScript CommandsScript Commands 

9.1 Executing Script CommandsExecuting Script CommandsExecuting Script CommandsExecuting Script Commands 
Script commands are executed from the Script Window. To open the Script Window, select 
the following from the PDPDPDPD72727272 Window menu: 
 [Window]->[Script Window] 
Enter script commands in the Command input area in the Script window. Click the 
Command input area to locate the cursor in that field, then enter the script command. 
After executing the command, the results are output to the execution result display area. 
 
 

Command input area 

Execution result display area 

Command history display area 
/Script file display area 

 
To re-execute a previously executed command 

The history of command execution is displayed in the command history display area. 
Double-click the command you want to execute again. 

 
To quit a script command that is executing 

Click the STOP button, which is displayed only while the command is being 
executed. 
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9.29.29.29.2    Logging the Results of ExecutingLogging the Results of ExecutingLogging the Results of ExecutingLogging the Results of Executing    
                    Script CommandsScript CommandsScript CommandsScript Commands    
Use the logging function to log the results of executing script commands. Before executing 
the script command, click the "LogOn" button on the toolbar of the Script Window.  

Clicking the "LogOn" button opens the File Selection dialog box. Specify the name of the 
file to be saved. The default file attribute, if omitted, is ".log". 
 

 

Click “LogOn” to start logging. 
 

 
You can also select the following from the PDPDPDPD72727272 Window menu (when the Script Window 
is active): 

 [Option]->[Log]->[On...] 
 
z If, after starting PDPDPDPD72727272, you open and close a log file, then re-open it, the new data 

is appended to the data already in that file. However, if you re-open a log file that 
was created before starting PDPDPDPD72727272, the contents of that file will be overwritten. 

z The file list in the File Selection dialog box starts with files with the ".log" attribute. 
However, you can enter a full filename (including the attribute) directly into the 
filename input area to open a log file with an attribute other than ".log". 

z You can nest log files up to 8 levels. 
 

To quit logging the results of executing script commands 
Click the "LogOff" button on the toolbar of the Script Window.  

 

Click “LogOff” to stop logging. 
 

 
You can also select the following from the PDPDPDPD72727272 Window menu (when the Script 
Window is active): 

 [Option]->[Log]->[Off] 
 

z When log files are nested, output to the current log file stops, but output to the 
next higher-level log file resumes. 
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To save the results of executing script commands after execution 
PDPDPDPD72727272 has a View Buffer that stores the results of executing the last 1000 lines of 
command results. To save the contents of the view buffer, click "View" on the 
toolbar of the Script Window.  

Clicking "View" opens the File Selection dialog box. Specify the name of the file to 
be saved. The default file attribute, if omitted, is ".viw". 

 

Click “View” to save the contents of the view buffer.  
 

You can also select the following from the PDPDPDPD72727272 Window menu (when the Script 
Window is active): 

  [Option]->[View]->[Save...] 
 

z When you specify an existing filename, the contents of the view buffer are 
appended to the existing file. 

z The file list in the File Selection dialog box starts with files with the ".viw" 
attribute. However, you can enter a full filename (including the attribute) 
directly into the filename input area to open a view file with an attribute other 
than ".viw". 

 
To clear the results of execution from the screen 

Click the "Clear" button on the menu in the Script Window to clear the contents of 
the command display.  
Note that the contents of the View buffer are cleared at the same time as the 
command display. 

 

Click the “Clear” button to clear the command display. 
 

You can also select the following from the PDPDPDPD72727272 Window menu (when the Script 
Window is active): 

 [Option]->[View]->[Clear] 
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9.3 Executing Script Commands in Batch ModeExecuting Script Commands in Batch ModeExecuting Script Commands in Batch ModeExecuting Script Commands in Batch Mode 
You can execute script commands in batches. To do so, use an editor to write the 
commands to be executed in a script file. Script files take the ".scr" attribute.  

Script files are opened from the Script Window. Click the "Open" button on the Script 
Window toolbar.  

When the file selection dialog box opens, select the script file to be executed. 
 

Click the “Open” button to open a script file. 

 
You can also select the following from the PDPDPDPD72727272 Window menu (when the Script Window 
is active): 

 [Option]->[Script]->[Open...] 
 
z The file list in the File Selection dialog box starts with files with the ".scr" attribute. 

However, you can enter a full filename (including the attribute) directly into the 
filename input area to open a script file with an attribute other than ".scr". 

z You can nest script files up to 5 levels. 
 
When a script file is read in, the command history display in the Script Window changes 
into the script file display. 

To execute the contents of the script file as a batch, click "Run" on the toolbar of the Script 
Window.  

Batch execution starts and the script file is then closed after all the commands have been 
executed. 
 

Click the “Run” button to execute all the commands in the script file in batch mode. 
 

You can also select the following from the PDPDPDPD72727272 Window menu (when the Script Window 
is active): 

 [Option]->[Script]->[Run] 
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To stop execution of a script file 

Click the STOP button displayed in the Running script dialog box. 
 

 
 

Execution of the script file stops before the next line. 
 

To independently execute each command in a script file 

You can also select the following from the PDPDPDPD72727272 Window menu (when the Script 
Window is active): 

  [Option]->[Script]->[Step] 
 

To close a script file 
Click the "Close" button on the Script Window toolbar. 

 

 

Click the "Close" button to close the script file.  
You can also close a script file by selecting the following (when the Script Window is 
active) from the PDPDPDPD72727272 Window menu: 

 [Option]->[Script]->[Close] 
 

z If the script files are nested, the current script file is closed and the next higher 
level script file is opened. 

 
 

Click the "Step" button on the Script Window toolbar (for step execution of the 
script). 
A command is executed each time you click the "Step" button. 
 

Click the "Step" button for step execution of the script file. 
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To execute a script file on PDPDPDPD72727272 startup 
Specify the name of the script file to be executed on startup in the Init dialog box 
which is displayed when you start PDPDPDPD72727272. 

 

 Specify the name of the script file  
to be executed on startup. 

 
You can also open the Init dialog box by selecting the following from the PDPDPDPD72727272 Window 
menu: 

 [Environ]->[Init] 
 



Exiting PDPDPDPD72727272 

 89

 

10. Exiting Exiting Exiting Exiting PD72 

10.110.110.110.1    Exiting Exiting Exiting Exiting PD72    
Select the following from the PDPDPDPD72727272 Window menu: 
 [File]->[Exit] 
A confirmation dialog box is displayed. Click OK to exit. 
 

 

Click the "OK" button. 
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11. MiscellaneousMiscellaneousMiscellaneousMiscellaneous 

11.111.111.111.1    Line AssembleLine AssembleLine AssembleLine Assemble    
Execute the assemble command (Assemble(A)) from the Script Window for line assembling. 
Specify the address for line assembling after the command. 
 

 >Assemble assemble-address 
 
On execution of the Assemble command, the command input area of the Script Window 
changes to a mnemonic input field. 

See Section 9.1, "Executing Script Commands" in the Basic Operation for details of how to 
use script commands. Enter the mnemonic for line assembling. The following shows the 
Script Window when waiting for a mnemonic to be input. 
 

Mnemonic input field

 
 

To exit the line assemble mode 
Specify "Enter" in the mnemonic input area. The Script Window changes back to 
the status in which it waits for a script command to be entered. 
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11.211.211.211.2    Searching for Character Strings in Target ProgramSearching for Character Strings in Target ProgramSearching for Character Strings in Target ProgramSearching for Character Strings in Target Program    
You can search for character strings in the target program when the Program Window or 
Source Window is active. Make sure the target Program or Source Window is active, then 
select the following from the PD72 Window menu: 
 [Edit]->[Find...] 
The Find dialog box is displayed. Enter the search string, then click "Find Next" to start the search. 
 

1. Specify the search string.

3. Check here to include wildcards in the search string.

4. Click "Down" to search the program forwards,

5. Click "Find Next" to start the search.

2. Check here if you want to differentiate between uppercase and lowercase letters.

or "Up" to search backwards.

 

11.311.311.311.3    Changing Window Proportions    
You can change the proportions of the Program Window, Source Window, Memory 
Window, and ASM Watch Window using the mouse as described below. 
 

z Program Window and Source Window 
When in disassemble display mode, you can change the relative proportions of 
the object code display area (<Objcode>) and the two parts (<Label> and 
<Mnemonic>) of the Program display area. 

Drag to resize.

 
 

z Memory Window 
You can change the relative proportions of the label display area (<LABEL>) and 
the memory content display area (<DATA>). 

Drag to resize.

 
 



PDPDPDPD72727272 User's Manual 

 92

z ASM Watch Window 
You can change the relative proportion of the expression display area (<Expr>). 

 
Drag to resize.

 
 

z Trace Window 
When in bus mode, you can change the relative proportion of the label display 
area (<LABEL>). 

 
D rag to resize .
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11.411.411.411.4    Displaying the Version of Displaying the Version of Displaying the Version of Displaying the Version of PD72    
Select the following from the PDPDPDPD72727272 Window menu: 
 [Help]->[About...] 
The About dialog box, which shows the PDPDPDPD72727272 version and monitor version, is displayed. 
  

 

PD72 version  

Monitor version Datafile name 

Debugger system 

 
Press "OK" to close the About dialog box. 
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[ MEMO ] 
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High-end Debugging 
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1. Coverage measurement 

Use the coverage measuring function to check addresses accessed during execution. The 
coverage measurement results can be referenced from the Coverage Window or using a 
script command, CoVerage (abbreviated CV). 

1.11.11.11.1    Displaying Coverage Measurement Result in PercentageDisplaying Coverage Measurement Result in PercentageDisplaying Coverage Measurement Result in PercentageDisplaying Coverage Measurement Result in Percentage    
Use the Coverage Window to show coverage measurement results in percentage. To open 
the Coverage Window, choose the following commands from the PDPDPDPD72727272 window menu: 
      [Window] -> [Coverage Window] 
Before displaying coverage measurement results in percentage, you must first set a range 
of addresses to be measured. For details about the Coverage Window, refer to Section 1.10, 
"Coverage Window" in the Window Function Part of this manual. 

 
To set a measurement address range 

Click the “Addarea” button on the Coverage Window tool bar. 

1.Click the “Addarea” button.

 
 
When you click the “Addarea” button, an Addarea dialog box opens.  Input a range of 
addresses to be measured in this dialog box. 

1. Specify the measurement start address. 

2.Specify the measurement end address. 

3.Click the “OK” button.
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To reference measurement results 
When you chose to show measurement results in percentage, they are displayed in 
the Coverage Window's measurement result display area. 

   95.75%0100      0121Sub1
   00.00%03F0      03FFdebug1

Measurement results in percentage

  100.00%0000      001FInit

 
 

Deleting a Measurement Address Range in Coverage Measurement Area 
Click on a line of a specified measurement address range in the Coverage Window 
that you want to be deleted. Then click the “Delarea” button. 

1.Click the delete area.

2.Click the “delarea” button.
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1.21.21.21.2    Referencing Coverage Measurement Results at Source LevelReferencing Coverage Measurement Results at Source LevelReferencing Coverage Measurement Results at Source LevelReferencing Coverage Measurement Results at Source Level    
Double-click on a line of measurement address range specified in the Coverage Window.  
The Coverage Source Window will appear. 

1.Double click

 
The lines that have been executed by the target program are displayed in light blue and 
those not executed are displayed in gray. 

Executed lines (light blue)

Unexecuted lines (gray)

 

1.31.31.31.3    Referencing Coverage Measurement Results at Address LReferencing Coverage Measurement Results at Address LReferencing Coverage Measurement Results at Address LReferencing Coverage Measurement Results at Address Levelevelevelevel    
Use a script command, CoVerage (abbreviated CV), for this purpose.  For details on how 
to use script commands, refer to Section 9.1, "Executing Script Commands" in the Basic 
Operation Part of this manual. The following shows reference examples where 
measurement results are referenced for accessed addresses in the address range of 000016 
to 03FF16. 

 
z To reference coverage measurement results one byte at a time in the 

address range of 000016 to 03FF16 
    >CoVerage  LOCAL, 0000,03FF>CoVerage  LOCAL, 0000,03FF>CoVerage  LOCAL, 0000,03FF>CoVerage  LOCAL, 0000,03FF    

 
z To reference coverage measurement results four bytes at a time in the 

address range of 000016 to 03FF16 
    >CoVerage  GLOBAL, 0000, 03FF>CoVerage  GLOBAL, 0000, 03FF>CoVerage  GLOBAL, 0000, 03FF>CoVerage  GLOBAL, 0000, 03FF    
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1.41.41.41.4    To initialize the previous results of coverage measurementsTo initialize the previous results of coverage measurementsTo initialize the previous results of coverage measurementsTo initialize the previous results of coverage measurements    
Click the “Clear” button on the Coverage Window tool bar. 

1.Click the “Clear” button.

 
Coverage measurement results can also be initialized using a CoVerage command. Enter 
the following to initialize the results of coverage measurements:  
    >CoVerage  CLEAR>CoVerage  CLEAR>CoVerage  CLEAR>CoVerage  CLEAR    

 
 

1.51.51.51.5    CCCCancelingancelingancelinganceling    the addressthe addressthe addressthe address    rangerangerangerange    of coverage measurement areaof coverage measurement areaof coverage measurement areaof coverage measurement area        
Click the measurement address range line to cancel in the Coverage Window, then click 

the "Delarea" button on the toolbar of the Coverage Window. 

 

1.Click the line

2. click the "Delarea" button
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1. Table of ScriTable of ScriTable of ScriTable of Script Commandspt Commandspt Commandspt Commands 

1.11.11.11.1    Input FormatInput FormatInput FormatInput Format    
z The format for entering PDPDPDPD72727272 script commands is as follows: 

1. Insert one or more spaces or tabs between the command and its parameter(s). 
2. You can use uppercase and lowercase letters and numerics for the command. 
 

z Description of symbols used in command format 
 

Parameter Command format 
XXXX XXXX must be input 
[XXXX] XXXX is optional 
{ X1 | X2 | X3 } One of X1, X2, or X3 must be input 
[{ X1 | X2 | X3 }] Input can be omitted, or you can input one of X1, X2, or X3 
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1.21.21.21.2    Tables of CommandsTables of CommandsTables of CommandsTables of Commands    
In the following tables of commands, commands shown with half-tone screening can be 
executed at run time. 

The abbreviated forms of commands are shown in parenthesis after the full command. 

See the PDPDPDPD72727272 on-line help for details of each command. To display on-line help, enter the 
following from the PDPDPDPD72727272 Window menu: 
 [Help]  ->  [Index] 
 

1.2.11.2.11.2.11.2.1    Execution CommandsExecution CommandsExecution CommandsExecution Commands    
Command Command format Summary 
Go(G) Go [StartAddress][,BreakAddress 

                    [:Pass Count]] 
Execute the target program. 

GoBreak(GB) GoBreak [StartAddress] Execute the target program at break table . 
STOP STOP Stop the target program. 
STATUS STATUS Display status of target program execution. 
Step(T) Step [number of steps] Step execution at source level. 
StepInstruction StepInstruction [number of steps] Step execution at machine language level. 
OverStep(TM) OverStep [number of steps] Over-step execution at source level. 
OverStepInstruction  OverStepInstruction  

                 [number of steps] 
Over-step execution at machine language level. 

Return Return Return execution at source level. 
ReturnInstruction ReturnInstruction Return execution at machine language level. 
Reset(Z) RESET Reset the target program. 
 

1.2.21.2.21.2.21.2.2    File Operation CommandsFile Operation CommandsFile Operation CommandsFile Operation Commands    
Command Command format Summary 
Load(I) Load filename[.hex|.hel|.heu|.sym] Download HEX/HEL/HEU/SYM file. 
Upload(O) Upload StartAddress,EndAddress 

                         ,Filename 
Output contents of specified memory area to hex file. 

 

1.2.31.2.31.2.31.2.3    Register Operation CommandsRegister Operation CommandsRegister Operation CommandsRegister Operation Commands    
Command Command format Summary 
Register(X) 1.Register [RegisterName] 

2.Register RegisterName,Value 
1.Check value of specified register. 
2.Set value in specified register. 
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1.2.41.2.41.2.41.2.4    Memory OperatMemory OperatMemory OperatMemory Operation Commandsion Commandsion Commandsion Commands    
Command Command format Summary 
Dump(D) Dump StartAddress[,EndAddress]] Display contents of ROM memory. 
DumpNibble(DI) DumpNibble [StartAddress[,EndAddress]] Display contents of RAM memory. 
Set(S) Set Address[,SetValue[,...]] Change contents of ROM memory at specified address. 

Enter "." to stop. 
SetNibble(SI) SetNibble Address[,SetValue[,...]] Change contents of RAM memory at specified address. 

Enter "." to stop. 
Fill(F) Fill StartAddress,EndAddress,SetValue Write specified data to specified ROM address range. 
FillNibble(FI) FillNibble StartAddress,EndAddress 

                              ,SetValue 
Write specified data to specified RAM address range. 

Move(M) Move StartAddress1,EndAddress 
                         ,StartAddress2 

Move contents of specified ROM memory range to 
destination address. 

MoveNibble(MI) MoveNibble StartAddress1,EndAddress 
                         ,StartAddress2 

Move contents of specified RAM memory range to 
destination address. 

 

1.2.51.2.51.2.51.2.5    Assemble/Disassemble CommandsAssemble/Disassemble CommandsAssemble/Disassemble CommandsAssemble/Disassemble Commands    
Command Command format Summary 
Assemble(A) Assemble [Address] Assemble line-by-line from specified address. 
DisAssemble(L) DisAssemble [StartAddress[,EndAddress]] Display result of disassembling specified area. 
BIT 1.BIT BitSymbol 

2.BIT BitSymbol,data 
1.Display bit symbol. 
2.Set value of bit showed by specified bitsymbol. 

EXPress(EXP) EXPress assembler expression Display value of specified assembler expression. 
 

1.2.61.2.61.2.61.2.6    Software Break Setting CommandsSoftware Break Setting CommandsSoftware Break Setting CommandsSoftware Break Setting Commands    
Command Command format Summary 
SoftwareBreak(SB) 1.SoftwareBreak 

2. SoftwareBreak address 
1.Display currently set software break points. 
2.Set software break point at specified address. 

SoftwareBreakClear(SBC) SoftwareBreakClear address Delete software break point at specified address. 
SoftwareBreakClearAl(SBCA) SoftwareBreakClearAll Delete all software break points. 
SoftwareBreakDisable (SBD) SoftwareBreakDisable address Disable software break point at specified address. 
SoftwareBreakDisableAll 
(SBDA) 

SoftwareBreakDisableAll Disable all software break points. 

SoftwareBreakEnable (SBE) SoftwareBreakEnable Address Enable software break point at specified address. 
SoftwareBreakEnableAll 
 (SBEA) 

SoftwareBreakEnableAll Enable all software break points. 

BREAKAT BREAKAT line No. [,filename] Set software break point at specified line No. 
 

1.2.71.2.71.2.71.2.7    Hardware Break Setting CommandsHardware Break Setting CommandsHardware Break Setting CommandsHardware Break Setting Commands    
Command Command format Summary 
HardwareBreak(HB) 1.HardwareBreak 

2.HardwareBreak  An, address [:PassCount] 
3.HardwareBreak  T, { H | L }[:PassCount] 
4.HardwareBreak {AND|OR|SEQ},{An|T}[,{An|T}[,{An|T}]] 
5.HardwareBreak NONE 

1. Reference hardware break 
point. 

2. Sets an address breakpoint 
3. Sets a trigger breakpoint. 
4. Set combination. 
5. H/W break point is disabled. 
 
See page 108 for details. 

BreakMode(BM) 1. BreakMode 
2. BreakMode { HARDWARE | SOFTWARE } 

1. Check mode of breaks. 
2. Change mode of breaks. 
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1.2.81.2.81.2.81.2.8    RealRealRealReal----Time Trace CommandsTime Trace CommandsTime Trace CommandsTime Trace Commands    
Command Command format Summary 
TracePoint(RP) 1.TracePoint 

2.TracePoint  A, address 
3.TracePoint  T, { H | L }[:PassCount] 
4.TracePoint  {A|T} 
5.TracePoint MODE,{{BEFORE|ABOUT|AFTER|BREAK} 

1. Reference trace point. 
2. Sets an address trace point. 
3. Sets a trigger trace point. 
4. Sets a valid trace point. 
5. Set trace condition. 
 
See page 110 for details. 

TraceData(RD, QD) TraceData [StartCycle] [,EndCycle] Display contents of real-time  
trace memory in bus signal  
format. 

TraceList(RL, QL) 
 

TraceList [StartCycle] [,end cycle] Display the contents of  
real-time trace memory in  
disassemble list format. 

TraceRange(RR) 
 

TraceRange Display the contents of 
real-time trace range. 

 

1.2.91.2.91.2.91.2.9    Coverage Measurement CommandsCoverage Measurement CommandsCoverage Measurement CommandsCoverage Measurement Commands    
Command Command format Summary 
CoVerage(CV) 1.Coverage LOCAL [,StartAddress, EndAddress] 

2.Coverage GLOBAL [,StartAddress, EndAddress] 
3.Coverage TOTAL [,StartAddress, EndAddress] 
4. Coverage CLEAR 
 

1.Display results of coverage 
measurements in 1-byte units. 

2.Display results of coverage 
measurements in 4-byte units. 

3.Display results of coverage 
measurements as percentages. 

4.Initialize memory for coverage 
measurements. 

 

1.2.101.2.101.2.101.2.10    RunRunRunRun----time Display Commandstime Display Commandstime Display Commandstime Display Commands    
Command Command format Summary 
TIME(MTD) 1. TIME 

2. TIME { ON | OFF } 
1. Display settings for run-time display. 
2. Set whether to display run time in 
  Script Window. 

MeasurementPoint 1.MeasurementPoint 
2.MeasurementPoint {START | END },address 
3.MeasurementPoint MODE, ModeNumber 
4.MeasurementPoint SHOW 

1.Display the measurement point setting.
2.Set measurement point address. 
3.Set measurement range. 
4.Display the measurement result. 
 
See page 112 for details. 

 

1.2.111.2.111.2.111.2.11    Script/LogScript/LogScript/LogScript/Log----File CommandsFile CommandsFile CommandsFile Commands    
Command Command format Summary 
SCRIPT SCRIPT filename Open script file. 
EXIT EXIT Close script file. 
WAIT  WAIT Wait for command input until target 

program stops. 
PAUSE PAUSE “MESSAGE” Display specified message in Pause dialog 

box and wait for user to press button. 
SLEEP SLEEP number of seconds Wait for command input for specified  

number of seconds. 
LOGON LOGON [ Filename [ .file attribute ]] Open log file. 
LOGOFF LOGGOFF Close log file. 
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1.2.121.2.121.2.121.2.12    Program Window Control CommandsProgram Window Control CommandsProgram Window Control CommandsProgram Window Control Commands    
Command Command format Summary 
PATH PATH [ search pass [ ;search pass ;.... ]] Set source file path. 
FILE 1.FILE  

2.FILE source filename  
1. List source files. 
2. Display specified source file. 

 

1.2.131.2.131.2.131.2.13    Utility CommandsUtility CommandsUtility CommandsUtility Commands    
Command Command format Summary 
RADIX 1.RADIX 

2. RADIX { 2 | 8 | 10 | 16 } 
1. Check radix for input of constants. 
2. Set radix for input of constants. 

ALIAS 1. ALIAS 
2. ALIAS new name , command name 

1. Check definition of command alias. 
2. Define command alias. 

UNALIAS UNALIAS new name Delete specified alias. 
UNALIASALL UNALIASALL Delete all aliases. 
VERsion(VER) VERsion Display PD72 and monitor versions. 
DATE DATE Display current date and time  

(yymmdd, day of week, and time). 
ECHO ECHO  “MESSAGE” Display specified parameter. 
QUIT QUIT Quit PD72. 
CD 1. CD 

2. CD directory_name 
1. Checks the current directory. 
2. Sets the current directory. 
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1.2.141.2.141.2.141.2.14    Supplementation explanation of Script CommandsSupplementation explanation of Script CommandsSupplementation explanation of Script CommandsSupplementation explanation of Script Commands    

HardwareBreak(HB)HardwareBreak(HB)HardwareBreak(HB)HardwareBreak(HB)    
Setting and Checking Hardware Breaks 

 
Input formatInput formatInput formatInput format 

(Format 1)  HardwareBreak 
(Format 2)  HardwareBreak An, address [:PassCount] 
(Format 3)  HardwareBreak T,  { H | L }[:PassCount] 
(Format 4)  HardwareBreak {AND|OR|SEQ}, { An | T } [, { An | T }  
                                                               [, { An | T } ]] 
(Format 5)  HardwareBreak NONE 
 
The following table shows the values that can be specified for An. 

An A1, A2 
 
FunctionFunctionFunctionFunction    
z Hardware breaks allow you to stop target program execution detection of an 

instruction fetch. 
z You can set up to 2 address and one external trigger break. 
z To use hardware breaks, use the BreakMode command as shown below to enable 

the break (Hardware can be abbreviated to H). 
  BreakMode HardwareBreakMode HardwareBreakMode HardwareBreakMode Hardware 
 
Setting Break PointsSetting Break PointsSetting Break PointsSetting Break Points    
 

Checking hardware break settings 
Use format 1. Enter the following to display the contents of the hardware break 
setting. 

        HardwareBreakHardwareBreakHardwareBreakHardwareBreak 
 

Stopping program execution on execution of the instruction at the specified address 
Use format 2. 

z Enter the following to stop execution of the target program on execution of 
the instruction at address 100h. 

  HardwareBreak A1, 100HardwareBreak A1, 100HardwareBreak A1, 100HardwareBreak A1, 100    
 
z Enter the following to stop execution of the target program on 5th execution 

of the instruction at address 312h. 
  HardwareBreak A1, 312:5HardwareBreak A1, 312:5HardwareBreak A1, 312:5HardwareBreak A1, 312:5    

 
To stop program execution when the external input signal changes to HIGH or LOW 
Use format 3. 

z Enter the following to stop program execution when the trigger signal 
changes to HIGH. 
    HardwareBreak T, HHardwareBreak T, HHardwareBreak T, HHardwareBreak T, H    
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Using Multiple Hardware Break PointsUsing Multiple Hardware Break PointsUsing Multiple Hardware Break PointsUsing Multiple Hardware Break Points    
The PC4400PC4400PC4400PC4400 allows you to set up to two address break points and one trigger break 
point. You can also combine these break point conditions to create more complex break 
points. 
 

To break program execution when all break point conditions are satisfied 
Use format 4. 

z Enter the following to stop program execution when all conditions for break 
points A1, A2, and T are satisfied. 
    HardwareBreak AND A1,A2,THardwareBreak AND A1,A2,THardwareBreak AND A1,A2,THardwareBreak AND A1,A2,T    
You can specify the break points in any order (For example, A2, A1, T has 
the same effect as A1, T, A2). 

 
To break program execution when any one of the break point conditions is satisfied 
Use format 4. 

z Enter the following to stop program execution when any one of break points 
A1, A2, or T is satisfied. 
 HardwareBreak OR, A1,A2,THardwareBreak OR, A1,A2,THardwareBreak OR, A1,A2,THardwareBreak OR, A1,A2,T    
You can specify the break points in any order. 

 
To break program execution when the break point conditions are satisfied in the 
specified order 
Use format 4. 

z Enter the following to stop program execution when the conditions for break 
point T are satisfied followed by those for break point A1. 
 HardwareBreak SEQ T,A1HardwareBreak SEQ T,A1HardwareBreak SEQ T,A1HardwareBreak SEQ T,A1    
When you use this format, specify the break point conditions in the order in 
which they must be satisfied for program execution to be stopped.    If you 
specify A1, T,  A1, T,  A1, T,  A1, T, for example, program execution stops if the conditions for A1 
are satisfied before those for T. 
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TracePoint (RP)TracePoint (RP)TracePoint (RP)TracePoint (RP)    
Setting and checking trace pointsSetting and checking trace pointsSetting and checking trace pointsSetting and checking trace points    

 
Input formatInput formatInput formatInput format 

(Format 1)  TracePoint 
(Format 2)  TracePoint A, address 
(Format 3)  TracePoint T, { H | L }[:PassCount] 
(Format 4)  TracePoint { A | T } 
(Format 5)  TracePoint MODE, { BEFORE | ABOUT | AFTER | BREAK } 
 

FunctionFunctionFunctionFunction    
z Trace points are the "yardsticks" for real-time tracing. You can use the trace points 

to specify what area is to be traced. Set the trace area using format 5. 
z Trace points are set using the same method as hardware breaks in the PC4400PC4400PC4400PC4400. In 

contrast to hardware breaks, in which target program execution stops when the 
specified conditions are satisfied, the locations at which the specified conditions are 
satisfied become the yardsticks for real-time tracing (the program does not stop). 
The trace point is said to have been passed when the specified condition is satisfied. 

z Real-time tracing is continuous and you can always check the results of the trace as 
soon as the target program stops.  

 
Setting trace pointsSetting trace pointsSetting trace pointsSetting trace points    
 

To examine the trace points set 
 

Use format 1. Enter the command as shown below to display the contents of the 
trace points set. 

        TracePointTracePointTracePointTracePoint 
 

To make a specified address the reference point of trace 
Use format 2. 

z Enter the command as shown below to make the address 100h the reference 
point of trace. 

  TracePointTracePointTracePointTracePoint A1, 100 A1, 100 A1, 100 A1, 100    
 

To make a high/low transition of an external input signal the reference point of trace 
Use format 3. 

z Enter the command as shown below to cause the program to stop at a 
high-going transition of a trigger signal. 
    TracePointTracePointTracePointTracePoint T, H T, H T, H T, H    
 

To set a valid reference point of trace 
Use format 4. 

z Enter the command as shown below to enable an address trace. 
    TracePointTracePointTracePointTracePoint    AAAA    
 
z Enter the command as shown below to enable a trigger trace. 

     TracePointTracePointTracePointTracePoint    TTTT 
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Setting the area for realSetting the area for realSetting the area for realSetting the area for real----time tracingtime tracingtime tracingtime tracing    
Use format 5. 
z Enter the following to check the results of the trace up to the set trace point. 

    TracePoint AREA, BEFORETracePoint AREA, BEFORETracePoint AREA, BEFORETracePoint AREA, BEFORE    
You can check the 4K cycles before the trace point. 

z Enter the following to check the results of the trace either side of the trace 
point. 
    TracePoint AREA, ABOUTTracePoint AREA, ABOUTTracePoint AREA, ABOUTTracePoint AREA, ABOUT    
You can check the 2K cycles before plus the 2K cycles after the trace point. 

z Enter the following to check the results of the trace after the trace point. 
    TracePoint AREA, AFTERTracePoint AREA, AFTERTracePoint AREA, AFTERTracePoint AREA, AFTER    
You can check the 4K cycles after the trace point. 

z Enter the following to check the results up to when the target program stops. 
    TracTracTracTracePoint AREA, BREAKePoint AREA, BREAKePoint AREA, BREAKePoint AREA, BREAK    
You can check the 4K cycles up to when the target program stops. This is 
the default setting when you start PD72. 
 

Figure 1 shows the relationship between the real-time trace area and the trace 
point. 
 

BREAK  Mode

BEFORE  Mode
AFTER Mode

ABOUT Mode

TRACE POINT

BREAK POINT

 
Figure 1  RealFigure 1  RealFigure 1  RealFigure 1  Real----time Trace Areatime Trace Areatime Trace Areatime Trace Area    
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MeasurementPoint (MP) MeasurementPoint (MP) MeasurementPoint (MP) MeasurementPoint (MP)     
Setting and Checking Measurement Points    

 
Input formatInput formatInput formatInput format 

(Format 1)  MeasurementPoint 
(Format 2)  MeasurementPoint { START | END } , Address  
(Format 3)  MeasurementPoint MODE, ModeNumber 
(Format 4)  MeasurementPoint SHOW 
 

FunctionFunctionFunctionFunction    
z The PC4400PC4400PC4400PC4400 emulator has the following four modes of time measurements 

available. 
 

No. Start Event End Event 
1. Start of program execution End of program execution 
2. Start of program execution Measurement point End 
3. Measurement point Start End of program execution 
4. Measurement point Start Measurement point End 

 
Checking measurement conditionChecking measurement conditionChecking measurement conditionChecking measurement condition    

Use format 1. 
z To reference the measurement conditions of the time measurement function, 

enter the command as follows: 
     MeasurementPointMeasurementPointMeasurementPointMeasurementPoint 

Setting measurement pointsSetting measurement pointsSetting measurement pointsSetting measurement points    
Use format 2. 
z To set the start point of time measurement at address 010016, enter the 

command as shown below. Note however that the start point of time 
measurement is valid only when the specified mode of time measurement is 
3 or 4. 
     MeasurementPoint START, MeasurementPoint START, MeasurementPoint START, MeasurementPoint START, 101010100000 

z To set the end point of time measurement at address 017F16, enter the 
command as shown below. Note however that the end point of time 
measurement is valid only when the specified mode of time measurement is 
2 or 4. 
     MeasurementPoint END, 17FMeasurementPoint END, 17FMeasurementPoint END, 17FMeasurementPoint END, 17F    

Setting measurement modeSetting measurement modeSetting measurement modeSetting measurement mode    
Use format 3. 
The default measurement mode is "1. From start of program execution till end of 
program execution." 
z To set the time measurement mode for "4. From measurement start point 

till measurement end point", enter the command as follows: 
     MeasurementPoint MODE,4MeasurementPoint MODE,4MeasurementPoint MODE,4MeasurementPoint MODE,4 

Checking measurement resultsChecking measurement resultsChecking measurement resultsChecking measurement results    
Use format 4. 
z To check the time measurement result, enter the command as follows: 

     MeasurementPoint SHOWMeasurementPoint SHOWMeasurementPoint SHOWMeasurementPoint SHOW 
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2.2.2.2.    Writing ScWriting ScWriting ScWriting Script Filesript Filesript Filesript Files    

PDPDPDPD72727272 allows you to run script files in a Script Window. The script file contains the 
controls necessary for automatically executing the script commands. 
 

2.12.12.12.1    Structural Elements of a Script FilStructural Elements of a Script FilStructural Elements of a Script FilStructural Elements of a Script Fileeee    
You can include the following in script files: 

z Script commands 
z Assign statements 
z Conditional statements (if, else, endi) 

Program execution branches to the statement(s) to be executed according to the 
result of the conditional expression. 

z Loop statements (while, endw) 
A block of one or more statements is repeatedly executed according to the 
expression. 

z break statement 
Exits from the innermost loop. 

z Comment statements 
You can include comments in a script file. The comment statements are ignored 
when the script commands are executed. 

Specify only one statement on each line of the script file. You cannot specify more than 
one statement on a line, or write statements that span two or more lines. 
 

2.1.12.1.12.1.12.1.1    Script CommandScript CommandScript CommandScript Commandssss    
You can use the same script commands that you enter in the Script Window. You can also 
call script files from within other script files (nesting up to 5 levels). 
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2.1.22.1.22.1.22.1.2    Assign StatementAssign StatementAssign StatementAssign Statementssss    
Assign statements define and initialize macro variables and assign values. The following 
shows the format to be used. 
 

%%%% macro macro macro macro----variablevariablevariablevariable =  =  =  = expressionexpressionexpressionexpression    
 

z You can use alphanumerics and the underscore (_) in macro variable names. 
However, you cannot use a numeric to start a macro variable name. 

z You can specify any expression of which the value is an integer between 016 and 
FFFFFFFF16 to be assigned in a macro variable. If you specify a negative number, 
it is processed as twos complement. 

z You can use macro variables within the expression. 
z Always precede macro variables with the "%" sign. 

 

2.1.32.1.32.1.32.1.3    Conditional StatementConditional StatementConditional StatementConditional Statements (ifs (ifs (ifs (if, endi, endi, endi, endi, else, else, else, else))))    
In a conditional statement, different statements are executed according to whether the 
condition is true or false. The following shows the format to be used. 
 

if ( if ( if ( if ( expressionexpressionexpressionexpression ) ) ) )    
     statement 1     statement 1     statement 1     statement 1    
elseelseelseelse    
     statement 2     statement 2     statement 2     statement 2    
endiendiendiendi    

 
z If the expression is true (other than 0), statement 1 is executed. If false, (0), 

statement 2 is executed. 
z You can omit the else statement. If omitted and the expression is false, execution 

jumps to the line after the endi statement. 
z if statements can be nested (up to 32 levels). 

 

2.1.42.1.42.1.42.1.4    Loop StatementLoop StatementLoop StatementLoop Statements (whiles (whiles (whiles (while, endw, endw, endw, endw) and Break Statement) and Break Statement) and Break Statement) and Break Statement    
In loop statements, execution of a group of statements is repeated while the expression is 
true. The following shows the format to be used. 
 

while ( while ( while ( while ( expression expression expression expression ))))    
     statement     statement     statement     statement    
endwendwendwendw    

 
z If the expression is true, the group of statements is repeated. If false, the loop is 

exited (and the statement following the endw statement is executed). 
z You can nest while statements up to 32 levels. 
z Use the break statement to forcibly exit a while loop. If while statements are 

nested, break exits from the innermost loop. 
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2.1.52.1.52.1.52.1.5    Comment statementComment statementComment statementComment statementssss    
You can include comments in a script file. Use the following format. 

 
 ; ; ; ; character string character string character string character string    

 
z Write the statement after a semicolon (;). You can include only spaces and tabs in 

front of the semicolon. 
z Lines with comment statements are ignored when the script file is executed. 

 
Notes:    

z You cannot include comments on the same lines as script commands. 
z You can nest script files up to five levels. 
z You can nest if statements and while statements up to 32 levels. 
z If statements must be paired with endi statements, and while statements with 

endw statements in each script file. 
z Expressions included in script files are evaluated as unsigned types. Therefore, 

operation cannot be guaranteed if you use negative values for comparison in if or 
while statements. 

z You can specify up to 4096 characters per line. An error occurs if a line exceeds 
this number of characters. 

z When a script file containing illegal commands is automatically executed (when 
you select [Option] -> [Script] -> [Run] from the Script Window menu after 
opening a script file, or click the <Run> button in the Script Window), execution 
of the script file continues even after the error is detected, except when the script 
line itself cannot be read. 
If an error is detected and the script file continues to be executed, operation after 
detection of the error cannot be guaranteed. Reliability cannot therefore be 
placed on the results of execution after an error has been detected. 
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2.22.22.22.2    Writing ExpressionsWriting ExpressionsWriting ExpressionsWriting Expressions    
PDPDPDPD72727272 allows you to use expressions for specifying addresses, data, and number of passes, 
etc. The following shows example commands using expressions. 
 
    >Dump TABLE1>Dump TABLE1>Dump TABLE1>Dump TABLE1    
 >Dump TABLE1+20>Dump TABLE1+20>Dump TABLE1+20>Dump TABLE1+20    
 

2.2.12.2.12.2.12.2.1    Elements of ExpressionsElements of ExpressionsElements of ExpressionsElements of Expressions    
You can use the following elements in expressions: 

z Constants 
z Symbols and labels 
z Macro variables 
z Register variables 
z Memory variables 
z Line Nos. 
z Character constants 
z Operators 

The following describes the respective elements. 
 

2.2.22.2.22.2.22.2.2    ConstantConstantConstantConstantssss    
You can use binary, octal, decimal, or hexadecimals. The prefix or suffix symbol attached 
to the numerical value indicates which radix is used. 

 
 Hexadecimal Decimal Octal Binary*1 
Prefix 0x,0X @ None % 
Suffix h,H None o,O b,B 
Examples 0xAB24 

AB24h 
@1234 1234o %10010 

10010b 
*1  You can only specify % when the predetermined radix is hexadecimal. 

 
z If you are inputting a radix that matches the predetermined radix, you can omit 

the symbol that indicates the radix (excluding binary). 
z Use the RADIX command to set the predetermined value of a radix. However, in 

the cases shown below, the radix is fixed regardless of what you specify in a 
RADIX command.  
 
Type Radix 
Address Hex 
Line No. 
No. of executions 
No. of passes 
No. of limits 

Dec 
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2.2.32.2.32.2.32.2.3    SymbolSymbolSymbolSymbols and labels and labels and labels and labelssss    
You can include symbols and labels defined in your target program, or symbols and labels 
defined using the Assemble command. 

z You can include alphanumerics, the underscore (_), period (.), and question mark 
(?) in symbols and labels. However, do not start with a numeric. 

z Symbols and labels can consist of up to 255 characters. 
z Uppercase and lowercase letters are unique. 
z You cannot include the assembler ASM72 pseudo instructions, macro 

instructions, operation code, or reserved words (.ORG, .IF, etc.). 
z You cannot use strings that start with two periods (..) for symbols or labels. 

 
Note 1:  Priority levels of labels and symbolsNote 1:  Priority levels of labels and symbolsNote 1:  Priority levels of labels and symbolsNote 1:  Priority levels of labels and symbols    

The conversion of values to labels or symbols, and vice versa, is subject to the following 
levels of priority: 

z Conversion of ROM address values 
1. Labels 
2. Symbols 

 
z Conversion of RAM address values 

1. ZXY symbols 
2. Bit symbols 

 
z Conversion of data values 

1. Symbols 
2. Labels 

 

2.2.42.2.42.2.42.2.4    Macro VariablesMacro VariablesMacro VariablesMacro Variables    
Macro variables are defined by assign statements in the script file. See Section 2.1, 
"Structural Elements of a Script File" in the Reference part for details. 

Precede variables with '%' for use as macro variables. 
z You can specify alphanumerics and/or the underbar (_) in the variable name 

following the percent sign (%). However, do not start the names with a numeric. 
z You cannot use the names of registers as variable names. 
z Uppercase and lowercase letters are differentiated in variable names. 
z You can define a maximum of 32 macro variables. Once defined, a macro variable 

remains valid until you quit PDPDPDPD72727272. 
 

Macro variables are useful for specifying the number of iterations of the while statement. 
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2.2.52.2.52.2.52.2.5    Register variablesRegister variablesRegister variablesRegister variables    
Register variables are used for using the values of registers in an expression. Precede the 
name of the register with '%' to use it as a register variable. Use the following format. 

 
    %register%register%register%register----namenamenamename 
 

You can use the following registers. 
 

PC, A, B, Z, PC, A, B, Z, PC, A, B, Z, PC, A, B, Z, XXXX, Y, CY, Y, CY, Y, CY, Y, CY    
 

Uppercase and lowercase letters are not unique in register names. You can specify either. 
 

2.2.62.2.62.2.62.2.6     Memory variables Memory variables Memory variables Memory variables    
Use RAM memory variables to use memory values in expressions. The format is as 
follows: 

 
    [RAM address].data[RAM address].data[RAM address].data[RAM address].data----sizesizesizesize    
 
z You can specify expressions in RAM addresses (you can also specify memory 

variables). 
Example 1: Referencing the contents of RAM memory at address 10016 

[100h] 
 

2.2.72.2.72.2.72.2.7     Line Nos. Line Nos. Line Nos. Line Nos.    
These are source file line Nos. The format for line Nos. is as follows: 

 
 #line_noline_noline_noline_no    
    #line_no.#line_no.#line_no.#line_no.”source file namesource file namesource file namesource file name”    
 
z Specify line Nos. in decimal. 
z You can only specify line Nos. in which software breaks can be set. 

You cannot specify lines in which no assembler instructions have been generated, 
including comment lines and blank lines. 

z If you omit the name of the source file, the line Nos. apply to the source file 
displayed in the Program Window. 

z Include the file attribute in the name of the source file. 
z Do not include any spaces between the line No. and name of the source file. 
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2.2.82.2.82.2.82.2.8     Character constants Character constants Character constants Character constants    
The specified character or character string is converted into ASCII code and processed as 
a constant. 

z Enclose characters in single quote marks. 
z Enclose character strings in double quote marks. 
z The character string must consist of one or two characters (16 bits max.). 

If more than two characters are specified, the last two characters of the string are 
processed. For example, "ABCD" would be processed as "CD", or value 434416. 

 

2.2.92.2.92.2.92.2.9     Operators Operators Operators Operators    
The table below lists the operators that you can use in expressions. 

z The priority of operators is indicated by the level, level 1 being the highest and 
level 8 the lowest. 
If two or more operators have the same level of priority, they are evaluated in 
order from the left of the expression. 
 
Operator Function Priority level 
( ) Brackets Level 1 
+, =, ~ Monadic positive, monadic negative, 

monadic logical NOT  
Level 2 

*, / Dyadic multiply, dyadic divide Level 3 
+, - Dyadic add, dyadic subtract Level 4 
>>, << Right shift, left shift Level 5 
& Dyadic logical AND Level 6 
|, ^ Dyadic logical OR, 

dyadic exclusive OR 
Level 7 

<, <=, >, >=, 
==, != 

Dyadic comparison Level 8 
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3. Error MessagesError MessagesError MessagesError Messages 

The following tables list the PDPDPDPD72727272 error messages. 
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

150 Can't open more (name) window. The maximum number of the specified 
window is already open. 

151 Can't Create (name) window. Cannot open the specified window. There may 
not be sufficient memory. Quit other 
applications or increase memory. 

152 Can't open (name) window, when the target 
program is running. 

Stop the target program, then open the 
window. 

153 Value is out of range. The specified address exceeds the MCU's 
maximum address. 

154 PDPDPDPD72727272 already running.  
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

200 Can't change view mode. The display starting address does not match 
the first line of the source file, or the specified 
source file cannot be found. 

201 Can't find source file (filename). Specified source file was not found. Use the 
PATH command, or the [Environ] -> [Path] 
menu items to specify the directory 
containing the source file. 

202 Can't find search string (name). The specified search string was not found 
between the starting position and end. 

203 Line number of Source File (filename) is over 
(line). 

Because the source file has more lines than 
can be displayed, the file cannot be displayed 
in the Source Window. Switch to disassemble 
display mode. 
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No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

300 Illegal endi(filename line). There is no if statement paired with the endi 
statement. 

301 Illegal endw(filename line). There is no while statement paired with the 
endw statement. 

303 Script File is already exist.   
304 Can't find endi(filename line). There is no endi statement paired with the if 

statement. 
305 Line length is overflow(filename line). The number of characters exceeds the 

maximum permissible for one line. 
306 Nest level is overflow(filename line).  
307 Can't find Script File(filename).  
308 Can't read Script File(filename). Cannot read rest of script file. 
309 Description is illegal(filename line).  
310 Can't find endw(filename line). There is no endw statement paired with while 

statement. 
311 Nest level is overflow(filename line).  
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

400 Address value is out range for scroll area.  
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

600 Can't add new watch point because it exceeds 
limit of watch point number. Max number 
is(num). 

 

601 Address value is out of range.  
602 Data value is out of range.  
603 Bit value is out of range.  
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

650 There are no symbol information.  Load module file not loaded. 
651 The expression is too long.  
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

900 SYMBOL file is illegal.  Error in format of load module file. 
901 Loading is canceled.  
902 Can't find SYMBOL file(filename). No load module file exists. 
903 Can't get enough memory. Insufficient memory. Quit other applications or 

increase memory. 
904 Can’t open temporary file. The temporary file for downloading using the 

on-demand method could be opened. 
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No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

1001 Can't find symbol.  Specified symbol does not exist. 
1002 Description of expression is illegal.  
1004 Description is illegal.  Error in expression. 
1006 Can't find symbol.   
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

1100 Address value is out of range. Specified address exceeds MCU's maximum 
address. 

1101 Description of Assembly language is illegal.  
1102 Address value for JUMP is out of range.  
1103 Operand value is out of range.  
1104 Description of expression is illegal.  
1107 Operand value is undefined.  
1108 Bit-symbol is in expression.  
1109 Invalid bit-symbol exist.  
1113 Characters exist in expression.  
1115 Invalid symbol definition.  
1116 Invalid reserved word exist in operand.  
1118 Reserved word is missing.  
1119 No space after mnemonic or directive.  
1123 Operand value is not defined.  
1124 Operand size is not appropriate.  
1125 Operand type is not appropriate.  
1131 Size or format specified is not appropriate.  
1132 Size specified is missing.  
1133 String value exist in expression.  
1134 Symbol is missing.  
1135 Symbol is multiple defined.  
1136 Symbol is missing.  
1137 Symbol is multiple defined.  
1138 Invalid operand exist in instruction.  
1139 Syntax error in expression.  
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

1153 Invalid operand exist in instruction.  
1154 Quote is missing.  
1155 Right quote is missing.  
1156 Can't get enough memory.  
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No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

1200 Syntax error.  
1201 Command name is wrong.  
1202 Too many aliases. Maximum: 256 
1203 You can register the only command name for 

alias. 
 

1204 Can't use the command now. You cannot use the specified command while 
the target program is running. 

1208 Already set hard ware break.  
1209 This command is not supported now.  
1210 The start address larger than the end 

address.    
 

1211 Can't register that token for alias.  
1212 The save file name (string1) is wrong. Specified file cannot exist. 
 
No.No.No.No.    Error MessageError MessageError MessageError Message    NotNotNotNotes and Actiones and Actiones and Actiones and Action    

1300 Line number is illegal.  
1302 The Number of Macro constant is over the 

limit (limit). 
 

1303 Immediate value is out of range.  
1304 Prefix which gives radix of the constant is 

illegal. 
 

1305 Description of indirect reference is illegal.  
1306 Can't find end of strings(str).  
1307 Description of expression is illegal.  
1308 Macro constant (macro) isn't defined.  
1309 Symbol (symbol) isn't defined.  
1310 Immediate value is illegal.  
1311 Divide by 0.  
1313 The value is over the maximum value of 

which can be treated by MCU. 
 

1314 Register name is using for macro variable 
name. 
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No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

1400 Address value is out of range. Specified address exceeds the MCU's 
maximum address. 

1401 Target program is already stopped.  
1402 The number of break point is over the 

limit(limit). 
 

1403 The break point isn't defined at that address.  
1404 Data value is out of range.  
1406 Can't read/write, because there are no 

memory at that area. 
Do not attempt to reference or write to an 
address for which no memory is installed.  

1407 Can't get enough memory. Insufficient memory. Quit other applications 
or increase memory. 

1408 Register value is out of range.  
1409 Can't execute that command, when the target 

program is running. 
 

1410 Start address is larger than end address.  
1411 STOP execution.  
1412 Can't find source lines which include that 

address. 
There is no source line information at the 
specified address. 

1413 That command has not yet supported.  
1417 Can't search more on the stack.  
1418 Specified times of number is over than 65535.  
1420 Breakpoint of other type already set. Check the type of breakpoint. 
1428 The specified register cannot be changed due 

to CPU restriction. 
 

1431 Stack overflow or underflow has occurred.  
1432 The time measurement counter has 

overflowed. 
 

1433 The specified register cannot be read due to 
CPU restriction 

 

1450 Address value is out of range.  
1452 Bit number is out of range.  
1453 STOP execution.  
1454 Data value is out of range.  
1456 Can't find File (filename).  
1460 The time measurement counter has 

overflowed. 
 

1462 Pass count value is out of range.  
1463 Can't execute that command, when the target 

program is running. 
 

1464 Target MCU is reset state. Reset the target system. 
1465 Target MCU is unable to reset. Reset the target system. 
1466 Target MCU is HOLD state.  
1467 Target MCU is not given clock.  
1468 Target MCU is not given power. Reset target system. 
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No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

1473 Can't find trace data which is able to refer.  
1474 Cycle value is out of range.  
1475 Target MCU is not under control.  Reset target system. 
1476 First data is larger than second data.  
1477 First address is larger than second address.  
 
 
No.No.No.No.    Error MessaError MessaError MessaError Messagegegege    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

1500 Address value is out of range. The specified address is greater than the 
MCU's maximum address 

1501 Bit number is out of range.  
1502 File (filename) is broken.  
1503 Can't find File(filename).  
1505 Illegal character in the strings.  
1507 Can't find that line number.  
1508 Multiple definition of symbol/label.  
1509 There are no code at that line. No machine language has been generated at 

the address corresponding to the specified 
line No. 

1510 Can't get enough memory.  
1513 Can't find source lines which correspond to 

that address.  
 

1514 Can't find symbol (symbol).  
1515 Can't find the scopes which include that 

address. 
 

1516 Loading is canceled.  
1519 The register name is wrong.  
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

2200 Can't execute more come instruction.  
2201 Can't find strings.  
2202 Can't execute more step instruction.  
2203 Cycle value is out of range.  
2204 Can't find that address.  
2205 Can't find File(filename). There is an error in the specified filename or 

no permission to read. 
2206 Can't find trace data.  
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No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

2400 Address value is out of range.  
2401 Data value is out of range.  
2402 Start Address value is out of range. You specified an ending address that is less 

than the starting address. 
2403 Value is under (num). Specify a value of num or more. 
2404 Data value is out of range.  
 
NoNoNoNo    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action 
2500 Operation code (ope-code) not found  
2501 File (filename) not found  
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

5200 Can't execute Come command, without 
unused break point. 

Delete one of the break points, then perform 
Come execution 

 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

5500 Value is out of range.  
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

5700 The data value is too large.   
5701 The address area is illegal.  
5702 Address value is out range for scroll area. The address specified as the scroll range is 

greater than the MCU's maximum address. 
 
No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

5900 Can't open Script File(filename).  
5901 Script File (filename) is already opened.  
5902 Script File is not open.  
5903 Can't open Log File (filename).  
5904 Can't open more Log File.  
5905 Can't open Log File.  
5906 File (filename) is already log on.  
5907 Can't open View File (filename) for new/add.  
 
No No No No     Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action 
10022 Can't execute more come instruction.  
10024 Can't execute more step instruction.  
10025 Cycle value is out of range.  
10026 Can't find that address.  
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No.No.No.No.    Error MessageError MessageError MessageError Message    Notes and ActionNotes and ActionNotes and ActionNotes and Action    

16004 The connection with the target isn't created.  
16005 Can't connect with the target.  
16007 Time Out ERROR. A time-out error occurred in communication 

with the target system. 
16012 Communication ERROR. Connection to the target system was lost 

during communication with the target 
system. 

16013 Communication ERROR. A communications error occurred while 
sending data to the target system. 

16014 Communication ERROR. A communications error occurred while 
receiving data from the target system. 
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